Concrete Frame Design Manual

Turkish TS 500-2000

with Turkish Seismic Code 2007

For SAP2000®
COPYRIGHT

Copyright © Computers and Structures, Inc., 1978-2011
All rights reserved.

The CSI Logo®, SAP2000®, ETABS® and SAFE® are registered trademarks of
Computers and Structures, Inc. Watch & Learn™ is a trademark of Computers and
Structures, Inc.

The computer programs SAP2000®, ETABS® and SAFE® and all associated docu-
mentation are proprietary and copyrighted products. Worldwide rights of ownership rest with
Computers and Structures, Inc. Unlicensed use of these programs or reproduction of
documentation in any form, without prior written authorization from Computers and
Structures, Inc., is explicitly prohibited.

No part of this publication may be reproduced or distributed in any form or by any means,
or stored in a database or retrieval system, without the prior explicit written permission of
the publisher.

Further information and copies of this documentation may be obtained from:

Computers and Structures, Inc.
1995 University Avenue
Berkeley, California  94704  USA

Phone: (510) 649-2200
FAX: (510) 649-2299
e-mail: info@csiberkeley.com (for general questions)
e-mail: support@csiberkeley.com (for technical support questions)
web: www.csiberkeley.com
DISCLAIMER

CONSIDERABLE TIME, EFFORT AND EXPENSE HAVE GONE INTO THE DEVELOPMENT AND DOCUMENTATION OF THIS SOFTWARE. HOWEVER, THE USER ACCEPTS AND UNDERSTANDS THAT NO WARRANTY IS EXPRESSED OR IMPLIED BY THE DEVELOPERS OR THE DISTRIBUTORS ON THE ACCURACY OR THE RELIABILITY OF THIS PRODUCT.

THIS PRODUCT IS A PRACTICAL AND POWERFUL TOOL FOR STRUCTURAL DESIGN. HOWEVER, THE USER MUST EXPPLICITLY UNDERSTAND THE BASIC ASSUMPTIONS OF THE SOFTWARE MODELING, ANALYSIS, AND DESIGN ALGORITHMS AND COMPENSATE FOR THE ASPECTS THAT ARE NOT ADDRESSED.

THE INFORMATION PRODUCED BY THE SOFTWARE MUST BE CHECKED BY A QUALIFIED AND EXPERIENCED ENGINEER. THE ENGINEER MUST INDEPENDENTLY VERIFY THE RESULTS AND TAKE PROFESSIONAL RESPONSIBILITY FOR THE INFORMATION THAT IS USED.
Contents

Chapter 1  Introduction  1-1
  1.1  Organization  1-2
  1.2  Recommended Reading/Practice  1-3

Chapter 2  Design Prerequisites  2-1
  2.1  Design Load Combinations  2-1
  2.2  Design and Check Stations  2-3
  2.3  Identifying Beams and Columns  2-3
  2.4  Design of Beams  2-4
  2.5  Design of Columns  2-4
  2.6  Design of Joints  2-5
  2.7  P-Delta Effects  2-6
  2.8  Element Unsupported Length  2-6
  2.9  Choice of Input Units  2-7
Chapter 3  Design Process

3.1 Notation 3-2

3.2 Design Load Combinations 3-5

3.3 Limits on Material Strength 3-6

3.4 Design Strength 3-7

3.5 Column Design 3-7

3.5.1 Generation of Biaxial Interaction Surface 3-8

3.5.2 Calculate Column Capacity Ratio 3-12

3.5.2.1 Determine Factored Moments and Forces 3-12

3.5.2.2 Determine Moment Magnification Factors 3-12

3.5.2.3 Determine Capacity Ratio 3-15

3.5.3 Required Reinforcing Area 3-16

3.5.4 Design Column Shear Reinforcement 3-16

3.5.4.1 Determine Section Forces 3-17

3.5.4.2 Determine Concrete Shear Capacity 3-22

3.5.4.3 Determine Required Shear Reinforcement 3-23

3.6 Beam Design 3-25

3.6.1 Design Beam Flexural Reinforcement 3-25

3.6.1.1 Determine Factored Moments 3-25

3.6.1.2 Determine Required Flexural Reinforcement 3-26

3.6.2 Design Beam Shear Reinforcement 3-35

3.6.2.1 Determine Shear Force and Moment 3-35

3.6.2.2 Determine Concrete Shear Capacity 3-37

3.6.2.3 Determine Required Shear Reinforcement 3-38

3.6.3 Design Beam Torsion Reinforcement 3-39

3.6.3.1 Determine Factored Torsion 3-39

3.6.3.2 Determine Special Section Properties 3-40

3.6.3.3 Determine Critical Torsion Capacity 3-41

3.6.3.4 Determine Torsion Reinforcement 3-42

3.7 Joint Design 3-44
### Contents

<table>
<thead>
<tr>
<th>3.7.1</th>
<th>Determine the Panel Zone Shear Force</th>
<th>3-44</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.7.2</td>
<td>Determine the Effective Area of Joint</td>
<td>3-46</td>
</tr>
<tr>
<td>3.7.3</td>
<td>Check Panel Zone Shear Stress</td>
<td>3-47</td>
</tr>
<tr>
<td>3.7.4</td>
<td>Beam-Column Flexural Capacity Ratios</td>
<td>3-47</td>
</tr>
</tbody>
</table>

#### Chapter 4  Design Output

| 4.1 | Overview | 4-1 |
| 4.2 | Graphical Display of Design Information | 4-2 |
| 4.2.1 | Input/Output | 4-2 |
| 4.3 | Tabular Display of Design output | 4-4 |
| 4.4 | Member Specific Information | 4-6 |
| 4.4.1 | Interactive Concrete Frame Design | 4-8 |

| 4.5 | Errors Messages and Warnings | 4-9 |

---

**Appendix A** Second Order P-Delta Effects

**Appendix B** Member Unsupported Lengths and Computation of K-Factors

**Appendix C** Concrete Frame Design Preferences

**Appendix D** Concrete Frame Overwrites

**Appendix E** Error Messages and Warnings

References
Chapter 1
Introduction

The design of concrete frames is seamlessly integrated within the program. Initiation of the design process, along with control of various design parameters, is accomplished using the Design menu.

Automated design at the object level is available for any one of a number of user-selected design codes, as long as the structures have first been modeled and analyzed by the program. Model and analysis data, such as material properties and member forces, are recovered directly from the model database, and no additional user input is required if the design defaults are acceptable.

The design is based on a set of user-specified loading combinations. However, the program provides default load combinations for each design code supported. If the default load combinations are acceptable, no definition of additional load combinations is required.

In the design of columns, the program calculates the required longitudinal and shear reinforcement. However, the user may specify the longitudinal steel, in which case a column capacity ratio is reported. The column capacity ratio gives an indication of the stress condition with respect to the capacity of the column.
The biaxial column capacity check is based on the generation of consistent three-dimensional interaction surfaces. It does not use any empirical formulations that extrapolate uniaxial interaction curves to approximate biaxial action.

Interaction surfaces are generated for user-specified column reinforcing configurations. The column configurations may be rectangular, square or circular, with similar reinforcing patterns. The calculation of moment magnification factors, unsupported lengths, and strength reduction factors is automated in the algorithm.

Every beam member is designed for flexure, shear, and torsion at output stations along the beam span.

All beam-column joints are investigated for existing shear conditions.

For special moment resisting frames (ductile frames), the shear design of the columns, beams, and joints is based on the probable moment capacities of the members. Also, the program will produce ratios of the beam moment capacities with respect to the column moment capacities, to investigate weak beam/strong column aspects, including the effects of axial force.

Output data can be presented graphically on the model, in tables for both input and output data, or on the calculation sheet prepared for each member. For each presentation method, the output is in a format that allows the engineer to quickly study the stress conditions that exist in the structure and, in the event the member reinforcing is not adequate, aids the engineer in taking appropriate remedial measures, including altering the design member without rerunning the entire analysis.

1.1 Organization

This manual is designed to help you quickly become productive with the concrete frame design options of TS 500-2000. Chapter 2 provides detailed descriptions of the Design Prerequisites used for TS 500-2000. Chapter 3 provides detailed descriptions of the code-specific process used for TS 500-2000. Chapter 4 documents the design output produced by program. The appendices provide details on certain topics referenced in this manual.
1.2  Recommended Reading/Practice

It is strongly recommended that you read this manual and review any applicable “Watch & Learn” Series™ tutorials, which are found on our web site, http://www.csiberkeley.com, before attempting to design a concrete frame. Additional information can be found in the on-line Help facility available from within the program’s main menu.
Chapter 2
Design Prerequisites

This chapter provides an overview of the basic assumptions, design preconditions, and some of the design parameters that affect the design of concrete frames.

In writing this manual it has been assumed that the user has an engineering background in the general area of structural reinforced concrete design and familiarity with TS 500-2000 codes.

2.1 Design Load Combinations

The design load combinations are used for determining the various combinations of the load cases for which the structure needs to be designed/checked. The load combination factors to be used vary with the selected design code. The load combination factors are applied to the forces and moments obtained from the associated load cases and are then summed to obtain the factored design forces and moments for the load combination.

For multi-valued load combinations involving response spectrum, time history, moving loads and multi-valued combinations (of type enveloping, square-root of the sum of the squares or absolute) where any correspondence between interacting quantities is lost, the program automatically produces multiple sub
combinations using maxima/minima permutations of interacting quantities. Separate combinations with negative factors for response spectrum cases are not required because the program automatically takes the minima to be the negative of the maxima for response spectrum cases and the permutations just described generate the required sub combinations.

When a design combination involves only a single multi-valued case of time history or moving load, further options are available. The program has an option to request that time history combinations produce sub combinations for each time step of the time history. Also an option is available to request that moving load combinations produce sub combinations using maxima and minima of each design quantity but with corresponding values of interacting quantities.

For normal loading conditions involving static dead load, live load, snow load, wind load, and earthquake load, or dynamic response spectrum earthquake load, the program has built-in default loading combinations for each design code. These are based on the code recommendations and are documented for each code in the corresponding manuals.

For other loading conditions involving moving load, time history, pattern live loads, separate consideration of roof live load, snow load, and so on, the user must define design loading combinations either in lieu of or in addition to the default design loading combinations.

The default load combinations assume all load cases declared as dead load to be additive. Similarly, all cases declared as live load are assumed additive. However, each load case declared as wind or earthquake, or response spectrum cases, is assumed to be non additive with each other and produces multiple lateral load combinations. Also wind and static earthquake cases produce separate loading combinations with the sense (positive or negative) reversed. If these conditions are not correct, the user must provide the appropriate design combinations.

The default load combinations are included in design if the user requests them to be included or if no other user-defined combination is available for concrete design. If any default combination is included in design, all default combinations will automatically be updated by the program any time the design code is changed or if static or response spectrum load cases are modified.
Live load reduction factors can be applied to the member forces of the live load case on an element-by-element basis to reduce the contribution of the live load to the factored loading.

The user is cautioned that if moving load or time history results are not requested to be recovered in the analysis for some or all of the frame members, the effects of those loads will be assumed to be zero in any combination that includes them.

2.2 Design and Check Stations

For each load combination, each element is designed or checked at a number of locations along the length of the element. The locations are based on equally spaced segments along the clear length of the element. The number of segments in an element is requested by the user before the analysis is performed. The user can refine the design along the length of an element by requesting more segments.

When using the TS 500-2000 design code, requirements for joint design at the beam-to-column connections are evaluated at the top most station of each column. The program also performs a joint shear analysis at the same station to determine if special considerations are required in any of the joint panel zones. The ratio of the beam flexural capacities with respect to the column flexural capacities considering axial force effect associated with the weak-beam/strong-column aspect of any beam/column intersection are reported.

2.3 Identifying Beams and Columns

In the program, all beams and columns are represented as frame elements, but design of beams and columns requires separate treatment. Identification for a concrete element is accomplished by specifying the frame section assigned to the element to be of type beam or column. If any brace element exists in the frame, the brace element also would be identified as a beam or a column element, depending on the section assigned to the brace element.
2.4 Design of Beams

In the design of concrete beams, in general, the program calculates and reports the required areas of steel for flexure and shear based on the beam moments, shears, load combination factors, and other criteria, which are described in detail in the code-specific manuals. The reinforcement requirements are calculated at a user-defined number of stations along the beam span.

All beams are designed for major direction flexure, shear and torsion only. Effects caused by any axial forces and minor direction bending that may exist in the beams must be investigated independently by the user.

In designing the flexural reinforcement for the major moment at a particular section of a particular beam, the steps involve the determination of the maximum factored moments and the determination of the reinforcing steel. The beam section is designed for the maximum positive and maximum negative factored moment envelopes obtained from all of the load combinations. Negative beam moments produce top steel. In such cases, the beam is always designed as a Rectangular section. Positive beam moments produce bottom steel. In such cases, the beam may be designed as a Rectangular beam or a T-beam. For the design of flexural reinforcement, the beam is first designed as a singly reinforced beam. If the beam section is not adequate, the required compression reinforcement is calculated.

In designing the shear reinforcement for a particular beam for a particular set of loading combinations at a particular station associated with beam major shear, the steps involve the determination of the factored shear force, the determination of the shear force that can be resisted by concrete, and the determination of the reinforcement steel required to carry the balance.

Special considerations for seismic design are incorporated into the program for the TS 500-2000 code.

2.5 Design of Columns

In the design of the columns, the program calculates the required longitudinal steel, or if the longitudinal steel is specified, the column stress condition is reported in terms of a column capacity ratio, which is a factor that gives an indication of the stress condition of the column with respect to the capacity of the
column. The design procedure for the reinforced concrete columns of the structure involves the following steps:

- Generate axial force-biaxial moment interaction surfaces for all of the different concrete section types in the model.

- Check the capacity of each column for the factored axial force and bending moments obtained from each loading combination at each end of the column. This step is also used to calculate the required reinforcement (if none was specified) that will produce a capacity ratio of 1.0.

The generation of the interaction surface is based on the assumed strain and stress distributions and some other simplifying assumptions. These stress and strain distributions and the assumptions are documented in Chapter 3.

The shear reinforcement design procedure for columns is very similar to that for beams, except that the effect of the axial force on the concrete shear capacity must be considered.

For certain special seismic cases, the design of columns for shear is based on the capacity shear. The capacity shear force in a particular direction is calculated from the moment capacities of the column associated with the factored axial force acting on the column. For each load combination, the factored axial load is calculated using the load cases and the corresponding load combination factors. Then, the moment capacity of the column in a particular direction under the influence of the axial force is calculated, using the uniaxial interaction diagram in the corresponding direction, as documented in Chapter 3.

### 2.6 Design of Joints

To ensure that the beam-column joint of special moment resisting frames possesses adequate shear strength, the program performs a rational analysis of the beam-column panel zone to determine the shear forces that are generated in the joint. The program then checks this against design shear strength.

Only joints that have a column below the joint are designed. The material properties of the joint are assumed to be the same as those of the column below the joint. The joint analysis is performed in the major and the minor directions of the column. The joint design procedure involves the following steps:
2.7  **P-Delta Effects**

The program design process requires that the analysis results include P-delta effects. The P-delta effects are considered differently for “braced” or “non-sway” and “unbraced” or “sway” components of moments in columns or frames. For the braced moments in columns, the effect of P-delta is limited to “individual member stability.” For unbraced components, “lateral drift effects” should be considered in addition to individual member stability effect. The program assumes that “braced” or “nonsway” moments are contributed from the “dead” or “live” loads, whereas, “unbraced” or “sway” moments are contributed from all other types of loads.

For the individual member stability effects, the moments are magnified with moment magnification factors, as documented in Chapter 3 of this manual.

For lateral drift effects, the program assumes that the P-delta analysis is performed and that the amplification is already included in the results. The moments and forces obtained from P-delta analysis are further amplified for individual column stability effect if required by the governing code, as in the TS 500-2000 codes.

Users of the program should be aware that the default analysis option is turned OFF for P-delta effect. The user can turn the P-delta analysis ON and set the maximum number of iterations for the analysis. The default number of iteration for P-delta analysis is 1. Further details about P-delta analysis are provided in Appendix A of this design manual.

2.8  **Element Unsupported Lengths**

To account for column slenderness effects, the column unsupported lengths are required. The two unsupported lengths are $l_{13}$ and $l_{22}$. These are the lengths between support points of the element in the corresponding directions. The
length $l_{33}$ corresponds to instability about the 3-3 axis (major axis), and $l_{22}$ corresponds to instability about the 2-2 axis (minor axis).

Normally, the unsupported element length is equal to the length of the element, i.e., the distance between END-I and END-J of the element. The program, however, allows users to assign several elements to be treated as a single member for design. This can be accomplished differently for major and minor bending, as documented in Appendix B of this design manual.

The user has options to specify the unsupported lengths of the elements on an element-by-element basis.

### 2.9 Choice of Input Units

English as well as SI and MKS metric units can be used for input. The codes are based on a specific system of units. All equations and descriptions presented in the subsequent chapters correspond to that specific system of units unless otherwise noted. For example, the TS 500-2000 code is published in mm-newton-second units. By default, all equations and descriptions presented in the “Design Process” chapter correspond to mm-newton-second units. However, any system of units can be used to define and design a structure in the program.
Chapter 3
Design Process

This chapter provides a detailed description of the code-specific algorithms used in the design of concrete frames when the TS 500-2000 codes have been selected. The menu option “TS 500-2000” also covers the “Specification for Structures to be Built in SEISMIC Areas, Part III - Earthquake Disaster Prevention” (EDP 2007). For simplicity, all equations and descriptions presented in this chapter correspond to mm-newton-second units unless otherwise noted.

For referring to pertinent sections of the corresponding code, a unique prefix is assigned for each code.

Reference to the TS 500-2000 code is identified with the prefix “TS.”

Reference to the Specification for Structures to be Built in Disaster Areas, Part III - Earthquake Disaster Prevention code is identified with the prefix “EDP.”
3.1 Notation

The various notations used in this chapter are described herein:

- \( A_g \) Gross area of concrete, \( \text{mm}^2 \)
- \( A_e \) Area enclosed by centerline of the outermost closed transverse torsional reinforcement, \( \text{mm}^2 \)
- \( A_s \) Area of tension reinforcement, \( \text{mm}^2 \)
- \( A'_s \) Area of compression reinforcement, \( \text{mm}^2 \)
- \( A_{sl} \) Area of longitudinal torsion reinforcement, \( \text{mm}^2 \)
- \( A_{ot}/s \) Area of transverse torsion reinforcement (closed stirrups) per unit length of the member, \( \text{mm}^2/\text{mm} \)
- \( A_{ov}/s \) Area of transverse shear reinforcement per unit length of the member, \( \text{mm}^2/\text{mm} \)
- \( A_{s(\text{required})} \) Area of steel required for tension reinforcement, \( \text{mm}^2 \)
- \( A_{st} \) Total area of column longitudinal reinforcement, \( \text{mm}^2 \)
- \( A_{sw} \) Area of shear reinforcement, \( \text{mm}^2 \)
- \( A_{sw}/s \) Area of shear reinforcement per unit length of the member, \( \text{mm}^2/\text{mm} \)
- \( C_m \) Coefficient, dependent upon column curvature, used to calculate moment magnification factor
- \( E_c \) Modulus of elasticity of concrete, \( \text{N/mm}^2 \)
- \( E_s \) Modulus of elasticity of reinforcement, \( 2 \times 10^5 \text{ N/mm}^2 \)
- \( I_g \) Moment of inertia of gross concrete section about centroidal axis, neglecting reinforcement, \( \text{mm}^4 \)
- \( I_{se} \) Moment of inertia of reinforcement about centroidal axis of member cross-section, \( \text{mm}^4 \)
- \( L \) Clear unsupported length, mm
$M_1$ Smaller factored end moment in a column, N-mm

$M_2$ Larger factored end moment in a column, N-mm

$M_c$ Factored moment to be used in design, N-mm

$M_{ns}$ Non-sway component of factored end moment, N-mm

$M_s$ Sway component of factored end moment, N-mm

$M_d$ Designed Factored moment at a section, N-mm

$M_{d2}$ Designed Factored moment at a section about 2-axis, N-mm

$M_{d3}$ Designed Factored moment at a section about 3-axis, N-mm

$N_b$ Axial load capacity at balanced strain conditions, N

$N_k$ Critical buckling strength of column, N

$N_{\text{max}}$ Maximum axial load strength allowed, N

$N_0$ Axial load capacity at zero eccentricity, N

$N_d$ Designed Factored axial load at a section, N

$V_c$ Shear force resisted by concrete, N

$V_E$ Shear force caused by earthquake loads, N

$V_{G+Q}$ Shear force from span loading, N

$V_{\text{max}}$ Maximum permitted total factored shear force at a section, N

$V_p$ Shear force computed from probable moment capacity, N

$V_s$ Shear force resisted by steel, N

$V_d$ Designed Factored shear force at a section, N

$a$ Depth of compression block, mm

$a_b$ Depth of compression block at balanced condition, mm

$a_{\text{max}}$ Maximum allowed depth of compression block, mm

$b$ Width of member, mm

$b_f$ Effective width of flange (T beam section), mm
$b_w$ Width of web (T beam section), mm
$c$ Depth to neutral axis, mm
$c_b$ Depth to neutral axis at balanced conditions, mm
$d$ Distance from compression face to tension reinforcement, mm
$d'$ Concrete cover to center of reinforcing, mm
$d_s$ Thickness of slab (T beam section), mm
$e_{min}$ Minimum eccentricity, mm
$f_{cd}$ Designed compressive strength of concrete, N/mm$^2$
$f_{ck}$ Characteristic compressive strength of concrete, N/mm$^2$
$f_{ctk}$ Characteristic tensile strength of concrete, N/mm$^2$
$f_{yd}$ Designed yield stress of flexural reinforcement, N/mm$^2$.
$f_{yk}$ Characteristic yield stress of flexural reinforcement, N/mm$^2$.
$f_{ywd}$ Designed yield stress of transverse reinforcement, N/mm$^2$.
$h$ Overall depth of a column section, mm
$k$ Effective length factor
$u_e$ Perimeter of centerline of outermost closed transverse torsional reinforcement, mm
$r$ Radius of gyration of column section, mm
$\alpha$ Reinforcing steel overstrength factor
$k_i$ Factor for obtaining depth of compression block in concrete
$R_{dus}$ Absolute value of ratio of maximum factored axial dead load to maximum factored axial total load i.e., creep coefficient
$\beta_s$ Moment magnification factor for sway moments
$\beta_{ns}$ Moment magnification factor for non-sway moments
$\varepsilon_c$ Strain in concrete
Design Load Combinations

The design load combinations are the various combinations of the prescribed response cases for which the structure is to be checked. The program creates a number of default design load combinations for a concrete frame design. Users can add their own design load combinations as well as modify or delete the program default design load combinations. An unlimited number of design load combinations can be specified.

To define a design load combination, simply specify one or more response cases, each with its own scale factor. The scale factors are applied to the forces and moments from the analysis cases to form the factored design forces and moments for each design load combination. There is one exception to the preceding. For spectral analysis modal combinations, any correspondence between the signs of the moments and axial loads is lost. The program uses eight design load combinations for each such loading combination specified, reversing the sign of axial loads and moments in major and minor directions.

As an example, if a structure is subjected to dead load, G, and live load, Q, only, the TS 500-2000 design check may need one design load combination only, namely, 1.4G +1.6Q. However, if the structure is subjected to wind, earthquake, or other loads, numerous additional design load combinations may be required.

The program allows live load reduction factors to be applied to the member forces of the reducible live load case on a member-by-member basis to reduce the contribution of the live load to the factored responses.

The design load combinations are the various combinations of the analysis cases for which the structure needs to be checked. For this code, if a structure is subjected to dead (G), live (Q), wind (W), and earthquake (E), and considering that

- $\varepsilon_{cu}$: Maximum usable compression strain allowed in extreme concrete fiber (0.003 mm/mm)
- $\varepsilon_s$: Strain in reinforcing steel
- $\gamma_m$: Material factor
- $\gamma_{mc}$: Material factor for concrete
- $\gamma_{ms}$: Material factor for steel

3.2 Design Load Combinations
wind and earthquake forces are reversible, the following load combinations may need to be defined (TS 6.2.6):

\[
\begin{align*}
1.4G + 1.6Q & \quad \text{(TS 6.3)} \\
0.9G \pm 1.3W & \quad \text{(TS 6.6)} \\
1.0G + 1.3Q \pm 1.3W & \quad \text{(TS 6.5)} \\
0.9G \pm 1.0E & \quad \text{(TS 6.8)} \\
1.0G + 1.0Q \pm 1.0E & \quad \text{(TS 6.7)}
\end{align*}
\]

These are also the default design load combinations in the program whenever the TS 500-2000 code is used. The user should use other appropriate design load combinations if roof live load is separately treated, or if other types of loads are present.

Live load reduction factors can be applied to the member forces of the live load analysis on a member-by-member basis to reduce the contribution of the live load to the factored loading.

When using the TS 500-2000 code, the program design assumes that a P-Delta analysis has been performed.

### 3.3 Limits on Material Strength

The characteristic compressive strength of concrete, $f_{ck}$, should not be less than 20 N/mm² (TS 3.1.1, EDP 3.2.5.1). The upper limit of the reinforcement yield stress, $f_y$, is taken as 420 N/mm² (EDP 3.2.5.3) and the upper limit of the reinforcement shear strength, $f_{sk}$ is taken as 420 N/mm² (EDP 3.2.5.3).

The program enforces the upper material strength limits for flexure and shear design of beams and columns or for torsion design of beams. The input material strengths are taken as the upper limits if they are defined in the material properties as being greater than the limits. The user is responsible for ensuring that the minimum strength is satisfied.
3.4 Design Strength

The design strength for concrete and steel is obtained by dividing the characteristic strength of the material by a partial factor of safety, $\gamma_{mc}$ and $\gamma_{ms}$. The values used in the program are as follows:

Partial safety factor for steel, $\gamma_{ms} = 1.15$, and \hspace{1cm} (TS 6.2.5)

Partial safety factor for concrete, $\gamma_{mc} = 1.5$. \hspace{1cm} (TS 6.2.5)

These factors are already incorporated in the design equations and tables in the code. Although not recommended, the program allows them to be overwritten. If they are overwritten, the program uses them consistently by modifying the code-mandated equations in every relevant place.

3.5 Column Design

The program can be used to check column capacity or to design columns. If the geometry of the reinforcing bar configuration of each concrete column section has been defined, the program will check the column capacity. Alternatively, the program can calculate the amount of reinforcing required to design the column based on provided reinforcing bar configuration. The reinforcement requirements are calculated or checked at a user-defined number of check/design stations along the column span. The design procedure for the reinforced concrete columns of the structure involves the following steps:

- Generate axial force-biaxial moment interaction surfaces for all of the different concrete section types of the model. A typical biaxial interacting diagram is shown in Figure 3-1. For reinforcement to be designed, the program generates the interaction surfaces for the range of allowable reinforcement; 1 to 4 percent for Ordinary, Nominal Ductility and High Ductility Moment Resisting (TS 7.4.1).

- Calculate the capacity ratio or the required reinforcing area for the factored axial force and biaxial (or uniaxial) bending moments obtained from each loading combination at each station of the column. The target capacity ratio is taken as the Utilization Factor Limit when calculating the required reinforcing area.
Design the column shear reinforcement.

The following four sections describe in detail the algorithms associated with this process.

### 3.5.1 Generation of Biaxial Interaction Surfaces

The column capacity interaction volume is numerically described by a series of discrete points that are generated on the three-dimensional interaction failure surface. In addition to axial compression and biaxial bending, the formulation allows for axial tension and biaxial bending considerations. A typical interaction surface is shown in Figure 3-1.

*Figure 3-1 A typical column interaction surface*
The coordinates of these points are determined by rotating a plane of linear strain in three dimensions on the section of the column, as shown in Figure 3-2. The linear strain diagram limits the maximum concrete strain, $\varepsilon_{\text{cu}}$, at the extremity of the section, to 0.003 (TS 7.1). The formulation is based consistently on the general principles of ultimate strength design (TS 7.1).

The stress in the steel is given by the product of the steel strain and the steel modulus of elasticity, $\varepsilon_s E_s$, and is limited to the yield stress of the steel, $f_{yd}$ (TS 7.1). The area associated with each reinforcing bar is assumed to be placed at the actual location of the center of the bar, and the algorithm does not assume any further simplifications with respect to distributing the area of steel over the cross-section of the column, as shown in Figure 3-2.
Figure 3-2 Idealized strain distribution for generation of interaction surface
The concrete compression stress block is assumed to be rectangular, with a stress value of $0.85f_{cd}$ (TS 7.1), as shown in Figure 3-3.

![Figure 3-3 Idealization of stress and strain distribution in a column section](image)

The interaction algorithm provides correction to account for the concrete area that is displaced by the reinforcement in the compression zone. The depth of the equivalent rectangular block, $a$, is taken as:

$$a = k_1 c$$  

(TS 7.1)

where $c$ is the depth of the stress block in compression strain and,

$$k_1 = 0.85 - 0.006(f_{ck} - 25), \quad 0.70 \leq k_1 \leq 0.85.$$  

(TS 7.1, Table 7.1)

The effect of the material factors, $\gamma_{mc}$ and $\gamma_{ms}$, are included in the generation of the interaction surface.

Default values for $\gamma_{mc}$ and $\gamma_{ms}$ are provided by the program but can be overwritten using the Preferences.

The maximum compressive axial load is limited to $N_{r\text{(max)}}$, where

$$N_{r\text{(max)}} = 0.6f_{ck}A_g$$ for gravity combinations  

(TS 7.4.1)  

$$N_{r\text{(max)}} = 0.5f_{ck}A_g$$ for seismic combinations
3.5.2 **Calculate Column Capacity Ratio**

The column capacity ratio is calculated for each design load combination at each output station of each column. The following steps are involved in calculating the capacity ratio of a particular column for a particular design load combination at a particular location:

- Determine the factored moments and forces from the analysis cases and the specified load combination factors to give \( N_d, M_{d2}, \) and \( M_{d3} \).

- Determine the moment magnification factors for the column moments.

- Apply the moment magnification factors to the factored moments. Determine if the point, defined by the resulting axial load and biaxial moment set, lies within the interaction volume.

The factored moments and corresponding magnification factors depend on the identification of the individual column as either “sway” or “non-sway.”

The following three sections describe in detail the algorithms associated with that process.

### 3.5.2.1 Determine Factored Moments and Forces

The loads for a particular design load combination are obtained by applying the corresponding factors to all of the analysis cases, giving \( N_d, M_{d2}, \) and \( M_{d3} \). The factored moments are further increased, if required, to obtain minimum eccentricities of \((15\text{mm} + 0.03h)\), where \( h \) is the dimension of the column in mm in the corresponding direction (TS 6.3.10). The minimum eccentricity is applied in both directions simultaneously. The minimum eccentricity moments are amplified for second order effects (TS 6.3.10, 7.6.2).

### 3.5.2.2 Determine Moment Magnification Factors

The moment magnification factors are calculated separately for sway (overall stability effect), \( \beta_s \), and for non-sway (individual column stability effect), \( \beta_{ns} \). Also, the moment magnification factors in the major and minor directions are, in general, different (TS 7.6.2.5, 7.6.2.6).
The moment obtained from analysis is separated into two components: the sway $M_s$ and the non-sway $M_{ns}$ components. The non-sway components, which are identified by “ns” subscripts, are primarily caused by gravity load. The sway components are identified by the “s” subscript. The sway moments are primarily caused by lateral loads and are related to the cause of sidesway.

For individual columns or column-members, the magnified moments about two axes at any station of a column can be obtained as

$$M_2 = M_{ns} + \beta_s M_s$$  

(TS 7.6.2.5)

The factor $\beta_s$ is the moment magnification factor for moments causing side-sway. The program takes this factor to be 1 because the component moments $M_s$ and $M_{ns}$ are assumed to be obtained from a second order elastic (P-\(\Delta\)) analysis (TS 7.6.1). For more information about P-\(\Delta\) analysis, refer to Appendix A.

For the P-\(\Delta\) analysis, the analysis combination should correspond to a load of 1.4 (dead load) + 1.6 (live load) (TS 6.2.6). See also White and Hajjar (1991). The user should use reduction factors for the moments of inertia in the program as specified in TS 6.3.7. The default moment of inertia factor in this program is 1.

The computed moments are further amplified for individual column stability effect (TS 7.6.2.5) by the non-sway moment magnification factor, $\beta_{ns}$, as follows:

$$M_d = \beta_{ns} M_2$$  

(TS 7.6.2.5)

$M_d$ is the factored moment to be used in design.

The non-sway moment magnification factor, $\beta_{ns}$, associated with the major or minor direction of the column is given by (TS 7.6.2.5)

$$\beta_{ns} = \frac{C_m}{1 - 1.3 \frac{N_d}{N_k}} \geq 1.0$$  

(TS 7.6.2.5, Eqn. 7.24)

$$C_m = 0.6 + 0.4 \frac{M_s}{M_2} \geq 0.4,$$  

(TS 7.6.2.5, Eqn. 7.25)
$M_1$ and $M_2$ are the moments at the ends of the column, and $M_2$ is numerically larger than $M_1$. $M_1/M_2$ is positive for single curvature bending and negative for double curvature bending. The preceding expression of $C_m$ is valid if there is no transverse load applied between the supports. If transverse load is present on the span, or the length is overwritten, $C_m = 1$. The user can overwrite $C_m$ on an object-by-object basis.

$$N_k = \frac{\pi^2 EI}{(kl_u)^2} \quad \text{(TS 7.6.2.4, Eqn. 7.19)}$$

$k$ is conservatively taken as 1; however, the program allows the user to overwrite this value (TS 7.6.2.2). $l_u$ is the unsupported length of the column for the direction of bending considered. The two unsupported lengths are $l_{22}$ and $l_{33}$, corresponding to instability in the minor and major directions of the object, respectively, as shown in Figure B-1 in Appendix B. These are the lengths between the support points of the object in the corresponding directions.

Refer to Appendix B for more information about how the program automatically determines the unsupported lengths. The program allows users to overwrite the unsupported length ratios, which are the ratios of the unsupported lengths for the major and minor axes bending to the overall member length.

$EI$ is associated with a particular column direction:

$$EI = \frac{0.4E_cg}{1 + R_m} \quad \text{(TS 7.6.2.4, Eqn. 7.21)}$$

$$R_m = \frac{\text{maximum factored axial sustained (dead) load}}{\text{maximum factored axial total load}} \leq 1.0 \quad \text{(TS 7.6.2.4, Eqn. 7.22)}$$

The magnification factor, $\beta_{ns}$, must be a positive number and greater than one. Therefore, $N_d$ must be less than $N_d/1.3$. If $N_d$ is found to be greater than or equal to $N_d/1.3$, a failure condition is declared.

The preceding calculations are performed for major and minor directions separately. That means that $\beta_{ns}$, $\beta_{ns}$, $C_m$, $k$, $l_u$, $EI$, and $R_m$ assume different values for major and minor directions of bending.
If the program assumptions are not satisfactory for a particular member, the user can explicitly specify values of $\beta_n$ and $\beta_{ns}$.

### 3.5.2.3 Determine Capacity Ratio

As a measure of the stress condition of the column, a capacity ratio is calculated. The capacity ratio is basically a factor that gives an indication of the stress condition of the column with respect to the capacity of the column.

Before entering the interaction diagram to check the column capacity, the moment magnification factors are applied to the factored loads to obtain $N_d$, $M_{d2}$, and $M_{d3}$. The point ($N_d$, $M_{d2}$, and $M_{d3}$) is then placed in the interaction space shown as point $L$ in Figure 3-4. If the point lies within the interaction volume, the column capacity is adequate. However, if the point lies outside the interaction volume, the column is overstressed.

This capacity ratio is achieved by plotting the point $L$ and determining the location of point $C$. Point $C$ is defined as the point where the line $OL$ (if extended outwards) will intersect the failure surface. This point is determined by three-dimensional linear interpolation between the points that define the failure surface, as shown in Figure 3-4. The capacity ratio, $CR$, is given by the ratio $OL/OC$.

- If $OL = OC$ (or $CR = 1$), the point lies on the interaction surface and the column is stressed to capacity.
- If $OL < OC$ (or $CR < 1$), the point lies within the interaction volume and the column capacity is adequate.
- If $OL > OC$ (or $CR > 1$), the point lies outside the interaction volume and the column is overstressed.

The maximum of all values of $CR$ calculated from each design load combination is reported for each check station of the column along with the controlling $N_d$, $M_{d2}$, and $M_{d3}$ set and associated design load combination name.
3.5.3 Required Reinforcing Area

If the reinforcing area is not defined, the program computes the reinforcement that will give a column capacity ratio equal to the Utilization Factor Limit, which is set to 0.95 by default.

3.5.4 Design Column Shear Reinforcement

The shear reinforcement is designed for each design combination in the major and minor directions of the column. The following steps are involved in designing the shear reinforcing for a particular column for a particular design load combination resulting from shear forces in a particular direction:
- Determine the factored forces acting on the section, $N_d$ and $V_d$. Note that $N_d$ is needed for the calculation of $V_c$.

- Determine the shear force, $V_c$, which can be resisted by concrete alone.

- Calculate the reinforcement steel required to carry the balance.

For High Ductility and Nominal Ductility moment resisting frames, the shear design of the columns is also based on the maximum probable moment resistance and the nominal moment resistance of the members, respectively, in addition to the factored shear forces (TS 8.1.4, EDP 3.3.7, 3.7.5). Effects of the axial forces on the column moment capacities are included in the formulation.

The following three sections describe in detail the algorithms associated with this process.

### 3.5.4.1 Determine Section Forces

- In the design of the column shear reinforcement of an Ordinary Moment Resisting concrete frame, the forces for a particular design load combination, namely, the column axial force, $N_d$, and the column shear force, $V_d$, in a particular direction are obtained by factoring the analysis cases with the corresponding design load combination factors.

- In the shear design of High Ductility and Nominal Ductility Moment Resisting Frames (i.e., seismic design), the shear capacity of the column is checked for capacity shear in addition to the requirement for the Ordinary Moment Resisting Frames. The maximum design shear force (force to be considered in the design) in the column, $V_d$, is determined from consideration of the maximum forces that can be generated at the column. Two different capacity shears are calculated for each direction (major and minor). The first is based on the maximum probable moment strength of the column, while the second is computed from the maximum probable moment strengths of the beams framing into the column. The design strength is taken as the minimum of these two values, but never less than the factored shear obtained from the design load combination.

$$ V_d = \min \left\{ V_c^c, V_c^b \right\} \geq V_{d,\text{factored}} $$

(EDP 3.3.7.1, Eqn. 3.5)
Concrete Frame Design TS 500-2000

where

\[ V_{c}^{e} = \text{Capacity shear force of the column based on the maximum probable maximum flexural strengths of the two ends of the column.} \]

\[ V_{c}^{h} = \text{Capacity shear force of the column based on the maximum probable moment strengths of the beams framing into the column.} \]

In calculating the capacity shear of the column, \( V_{c}^{e} \), the maximum probable flexural strength at the two ends of the column is calculated for the existing factored axial load. Clockwise rotation of the joint at one end and the associated counter-clockwise rotation of the other joint produces one shear force. The reverse situation produces another capacity shear force, and both of these situations are checked, with the maximum of these two values taken as the \( V_{c}^{e} \).

For each design load combination, the factored axial load, \( N_{d} \), is calculated. Then, the maximum probable positive and negative moment strengths, \( M_{pr}^{+} \) and \( M_{pr}^{-} \), of the column in a particular direction under the influence of the axial force \( N_{d} \) is calculated using the uniaxial interaction diagram in the corresponding direction. Then the capacity shear force is obtained by applying the calculated maximum probable ultimate moment strengths at the two ends of the column acting in two opposite directions. Therefore, \( V_{c}^{e} \) is the maximum of \( V_{c1}^{e} \) and \( V_{c2}^{e} \),

\[ V_{c}^{e} = \max \{ V_{c1}^{e}, V_{c2}^{e} \} \leq 0.22 f_{cd} A_{w} \quad \text{(EDP 3.3.7.1, 3.3.7.5)} \]

where,

\[ V_{c1}^{e} = \frac{M_{i}^{+} + M_{j}^{-}}{L}, \quad \text{(EDP 3.3.7.1, Fig. 3.3, 3.5)} \]

\[ V_{c2}^{e} = \frac{M_{i}^{-} + M_{j}^{+}}{L}, \quad \text{(EDP 3.3.7.1, Fig. 3.3, 3.5)} \]
\[ M_i^+ , M_i^- = \text{Positive and negative probable maximum moment strengths} \]
\[ (M_{pr}^+ , M_{pr}^-) \text{ at end } I \text{ of the column using a steel yield stress value of } f_{yd} \text{ and a concrete stress } f_{cd}, \]

\[ M_j^+ , M_j^- = \text{Positive and negative probable maximum moment strengths} \]
\[ (M_{pr}^+ , M_{pr}^-) \text{ at end } J \text{ of the column using a steel yield stress value of } f_{yd} \text{ and a concrete stress } f_{cd}, \text{ and} \]

\[ L = \text{Clear span of the column.} \]

If the column section was identified as a section to be checked, the user-specified reinforcing is used for the interaction curve. If the column section was identified as a section to be designed, the reinforcing area envelope is calculated after completing the flexural (P-M-M) design of the column. This envelope of reinforcing area is used for the interaction curve.

If the column section is a variable (non-prismatic) section, the cross-sections at the two ends are used, along with the user-specified reinforcing or the envelope of reinforcing for check or design sections, as appropriate. If the user overwrites the length factor, the full span length is used. However, if the length factor is not overwritten by the user, the clear span length will be used. In the latter case, the maximum of the negative and positive moment capacities will be used for both the positive and negative moment capacities in determining the capacity shear.

In calculating the capacity shear of the column based on the flexural strength of the beams framing into it, \( V_e^b \), the program calculates the maximum probable positive and negative moment strengths of each beam framing into the top joint of the column. Then the sum of the beam moments is calculated as a resistance to joint rotation. Both clockwise and counter-clockwise rotations are considered separately, as well as the rotation of the joint in both the major and minor axis directions of the column. The shear force in the column is determined assuming that the point of inflection occurs at mid-span of the columns above and below the joint. The effects of load reversals are investigated and the design is based on the maximum of the joint shears obtained from the two cases.

\[ V_e^b = \max \{ V_{e1}^b , V_{e2}^b \} \quad \text{(EDP 3.3.7.1, Fig. 3.3, 3.5)} \]
where,

\[ V_{e1}^b = \text{Column capacity shear based on the maximum probable flexural strengths of the beams for clockwise joint rotation}, \]

\[ V_{e2}^b = \text{Column capacity shear based on the maximum probable flexural strengths of the beams for counter-clockwise joint rotation}, \]

\[ V_{e1}^b = \frac{M_{r1}}{H}, \]

\[ V_{e2}^b = \frac{M_{r2}}{H}, \]

\[ M_{r1} = \text{Sum of beam moment resistances with clockwise joint rotations}, \]

\[ M_{r2} = \text{Sum of beam moment resistances with counter-clockwise joint rotations}, \]

\[ H = \text{Distance between the inflection points, which is equal to the mean height of the columns above and below the joint. If there is no column at the top of the joint, the distance is taken as one-half of the height of the column at the bottom of the joint.} \]

For the case shown in Figure 3-5, \( V_{e1}^b \) can be calculated as follows:

\[ V_{e1}^b = \frac{M_r^L + M_r^R}{H} \]

It should be noted that the points of inflection shown in Figure 3-5 are taken at midway between actual lateral support points for the columns, and \( H \) is taken as the mean of the two column heights. If no column is present at the top of the joint, \( H \) is taken to be equal to one-half the height of the column below the joint.

The expression \( V_{e1}^b \) is applicable for determining both the major and minor direction shear forces. The calculated shear force is used for the design of the column below the joint. When beams are not oriented along the major and minor axes of the column, the appropriate components of the flexural capacities are used. If the beam is oriented at an angle \( \theta \) with the column major axis, the ap-
appropriate component—$M_{pr} \cos \theta$ or $M_{pr} \sin \theta$—of the beam flexural strength is used in calculating $M_{r1}$ and $M_{r2}$. Also the positive and negative moment capacities are used appropriately based on the orientation of the beam with respect to the column local axis.

- For Nominal Ductility Moment Resisting Frames, the shear capacity of the column is same as for Ordinary Moment Resisting Frames.

\[ V_d \leq 0.22A_n f_{cd} \]  

(EDP 3.3.7.5, 3.7.5.3, Eqn. 3.5)

---

**Figure 3-5 Column shear force $V_d$**

---

---
where, \( V_c \) is the capacity shear force in the column determined from the probable moment capacities of the column and the beams framing into it.

\[
V_c = \min \left\{ V_{c}^{c}, V_{e}^{b} \right\}
\]

(EDP 3.4.5.1, 3.4.5.2)

where, \( V_{c}^{c} \) is the capacity shear force of the column based on the probable flexural strength of the column ends alone. \( V_{e}^{b} \) is the capacity shear force of the column based on the probable flexural strengths of the beams framing into it. The calculation of \( V_{c}^{c} \) and \( V_{e}^{b} \) is the same as that described for High Ductility Moment Resisting Frames.

- For Ordinary Moment Resisting Frames, the shear capacity for those columns is checked based on the factored shear force.

### 3.5.4.2 Determine Concrete Shear Capacity

Given the design force set \( N_d \) and \( V_d \), the shear force carried by the concrete, \( V_c \), is calculated as follows:

- If the column is subjected to axial loading, \( N_d \) is positive in this equation regardless of whether it is a compressive or tensile force,

\[
V_{cr} = 0.65 f_{cd} b_w d \left( 1 + \frac{\gamma N_d}{A_g} \right),
\]

(TS 8.1.3, Eqn. 8.1)

where,

- \( 0.07 \) for axial compression
- \( \gamma = -0.3 \) for axial tension
- \( 0 \) when tensile stress < 0.5 MPa

\[
V_c = 0.8 V_{cr},
\]

(TS 8.1.4, Eqn. 8.4)

- For High Ductility Moment Resisting Concrete Frame design, if the factored axial compressive force, \( N_d \), including the earthquake effect, is small \( \left( N_d < 0.05 f_{ck} A_g \right) \) and if the shear force contribution from earthquake, \( V_{E} \), is
more than half of the total factored maximum shear force $V_d (V_E \geq 0.5 V_d)$ over the length of the member, and if the station is within a distance $l_o$ from the face of the joint, then the concrete capacity $V_c$ is taken as zero (EDP 3.7.6). Note that for capacity shear design, $V_E$ is considered to be contributed solely by earthquakes, so the second condition is automatically satisfied. The length $l_o$ is taken as the section width, one-sixth the clear span of the column, or 500 mm, whichever is larger (EDP 3.3.4.1, 3.3.7.6).

![Figure 3-6 Shear stress area, $A_{cv}$](image)

**3.5.4.3 Determine Required Shear Reinforcement**

Given $V_d$ and $V_c$, the required shear reinforcement in the form of stirrups or ties within a spacing, $s$, is given for rectangular and circular columns by the following:
The shear force is limited to a maximum of

\[ V_{\text{max}} = 0.22 f_{cd} A_v \]  

(TS 8.1.5b, EDP 3.3.7.5)

The required shear reinforcement per unit spacing, \( A_v/s \), is calculated as follows:

If \( V_d \leq V_{cr} \),

\[ \frac{A_{nv}}{s} = 0.3 \frac{f_{cd}}{f_{ywd}} b_w, \]  

(TS 8.1.5, Eqn. 8.6)

else if \( V_{cr} < V_d \leq V_{\text{max}} \),

\[ \frac{A_{nv}}{s} = \frac{(V_d - V_{cr})}{f_{ywd} d}, \]  

(TS 8.1.4, Eqn. 8.5)

\[ \frac{A_{nv}}{s} \geq 0.3 \frac{f_{cd}}{f_{ywd}} b_w \]  

(TS 8.1.5, Eqn. 8.6)

else if \( V_d > V_{\text{max}} \),

a failure condition is declared.  

(TS 8.1.5b)

In the preceding expressions, for a rectangular section, \( b_w \) is the width of the column, \( d \) is the effective depth of the column. For a circular section, \( b_w \) is replaced with \( D \), which is the external diameter of the column, and \( d \) is replaced with \( 0.8D \) and \( A_v \) is replaced with the gross area.

If \( V_d \) exceeds its maximum permitted value \( V_{\text{max}} \), the concrete section size should be increased (TS 8.1.5b).

The maximum of all calculated \( A_{nv}/s \) values, obtained from each design load combination, is reported for the major and minor directions of the column, along with the controlling combination name.

The column shear reinforcement requirements reported by the program are based purely on shear strength consideration. Any minimum stirrup require-
ments to satisfy spacing considerations or transverse reinforcement volumetric considerations must be investigated independently of the program by the user.

3.6 Beam Design

In the design of concrete beams, the program calculates and reports the required areas of steel for flexure and shear based on the beam moments, shear forces, torsions, design load combination factors, and other criteria described in the text that follows. The reinforcement requirements are calculated at a user-defined number of check/design stations along the beam span.

All beams are designed for major direction flexure, shear and torsion only. Effects resulting from any axial forces and minor direction bending that may exist in the beams must be investigated independently by the user.

The beam design procedure involves the following steps:

- Design flexural reinforcement
- Design shear reinforcement
- Design torsion reinforcement

3.6.1 Design Beam Flexural Reinforcement

The beam top and bottom flexural steel is designed at check/design stations along the beam span. The following steps are involved in designing the flexural reinforcement for the major moment for a particular beam for a particular section:

- Determine the maximum factored moments
- Determine the reinforcing steel

3.6.1.1 Determine Factored Moments

In the design of flexural reinforcement of Special, Intermediate, or Ordinary Moment Resisting concrete frame beams, the factored moments for each design load combination at a particular beam section are obtained by factoring the
corresponding moments for different analysis cases with the corresponding design load combination factors.

The beam section is then designed for the factored moments obtained from all of the design load combinations. Positive moments produce bottom steel. In such cases, the beam may be designed as a Rectangular or a T beam. Negative moments produce top steel. In such cases, the beam is always designed as a rectangular section.

3.6.1.2 Determine Required Flexural Reinforcement

In the flexural reinforcement design process, the program calculates both the tension and compression reinforcement. Compression reinforcement is added when the applied design moment exceeds the maximum moment capacity of a singly reinforced section. The user has the option of avoiding the compression reinforcement by increasing the effective depth, the width, or the grade of concrete.

The design procedure is based on the simplified rectangular stress block, as shown in Figure 3-7 (TS 7.1). When the applied moment exceeds the moment capacity at this design condition, the area of compression reinforcement is calculated on the assumption that the additional moment will be carried by compression and additional tension reinforcement.

The design procedure used by the program for both rectangular and flanged sections (T beams) is summarized in the following subsections. It is assumed that the design ultimate axial force does not exceed \( 0.1f_{ck} A_g \) (TS 7.3); hence, all of the beams are designed ignoring axial force.

3.6.1.2.1 Design for Rectangular Beam

In designing for a factored negative or positive moment, \( M_d \) (i.e., designing top or bottom steel), the depth of the compression block is given by \( a \) (see Figure 3-7), where,
The maximum depth of the compression zone, \( c_b \), is calculated based on the compressive strength of the concrete and the tensile steel tension using the following equation (TS 7.1):

\[
c_b = \frac{\varepsilon_{cu} E_s}{\varepsilon_{cu} E_s + f_{yld}} d
\]

The maximum allowable depth of the rectangular compression block, \( a_{\text{max}} \), is given by

\[
a_{\text{max}} = 0.85 k_1 c_b
\]

where \( k_1 \) is calculated as follows:
$k_1 = 0.85 - 0.006(f_{ck} - 25), \quad 0.70 \leq k_1 \leq 0.85. \quad \text{(TS 7.1, Table 7.1)}$

- If $a \leq a_{\text{max}}$, the area of tensile steel reinforcement is then given by:

$$A_t = \frac{M_d}{f_{yd}(d - \frac{a}{2})}$$

This steel is to be placed at the bottom if $M_d$ is positive, or at the top if $M_d$ is negative.

- If $a > a_{\text{max}}$, compression reinforcement is required (TS 7.1) and is calculated as follows:

The compressive force developed in concrete alone is given by:

$$C = 0.85 f'_{cd} b a_{\text{max}}, \quad \text{(TS 7.1)}$$

the moment resisted by concrete compression and tensile steel is:

$$M_{dc} = C \left(d - \frac{a_{\text{max}}}{2}\right).$$

Therefore, the moment resisted by compression steel and tensile steel is:

$$M_{ds} = M_d - M_{dc}.$$

So the required compression steel is given by:

$$A'_c = \frac{M_{ds}}{(\sigma'_{s} - 0.85 f_{cd})(d - d')}, \text{ where}$$

$$\sigma'_{s} = E_s \varepsilon_{cd} \left[\frac{c_{\text{max}} - d'}{c_{\text{max}}}\right] \leq f_{yd}.$$

The required tensile steel for balancing the compression in concrete is:

$$A_{s1} = \frac{M_{ds}}{f_{yd}(d - \frac{a_{\text{max}}}{2})}, \text{ and}$$
the tensile steel for balancing the compression in steel is given by:

\[ A_{s2} = \frac{M_{ds}}{f_{yd} (d - d')} \]

Therefore, the total tensile reinforcement is \( A_s = A_{s1} + A_{s2} \), and the total compression reinforcement is \( A'_s \). \( A_s \) is to be placed at the bottom and \( A'_s \) is to be placed at the top if \( M_d \) is positive, and \( A'_s \) is to be placed at the bottom and \( A_s \) is to be placed at the top if \( M_d \) is negative.

### 3.6.1.2.2 Design for T-Beam

In designing a T-beam, a simplified stress block, as shown in Figure 3-8, is assumed if the flange is under compression, i.e., if the moment is positive. If the moment is negative, the flange comes under tension, and the flange is ignored. In that case, a simplified stress block similar to that shown in Figure 3-8 is assumed in the compression side (TS 7.1).

![Figure 3-8 T-beam design](image)

**Figure 3-8 T-beam design**

**Flanged Beam Under Negative Moment**

In designing for a factored negative moment, \( M_d \) (i.e., designing top steel), the calculation of the steel area is exactly the same as described for a rectangular beam, i.e., no T beam data is used.
Flanged Beam Under Positive Moment

If $M_d > 0$, the depth of the compression block is given by

$$a = d - \sqrt{d^2 - \frac{2M_d}{0.85 f_{cd} b_f}}$$

The maximum depth of the compression zone, $c_b$, is calculated based on the compressive strength of the concrete and the tensile steel tension using the following equation (TS 7.1):

$$c_b = \frac{\varepsilon_c E_s}{\varepsilon_{cu} E_s + f_{yd}} d$$  \hspace{1cm} (TS 7.1)

The maximum allowable depth of the rectangular compression block, $a_{\text{max}}$, is given by

$$a_{\text{max}} = 0.85 k_1 c_b$$  \hspace{1cm} (TS 7.11, 7.3, Eqn. 7.4)

where $k_1$ is calculated as follows:

$$k_1 = 0.85 - 0.006 (f_{ck} - 25), \quad 0.70 \leq k_1 \leq 0.85.$$  \hspace{1cm} (TS 7.1, Table 7.1)

If $a \leq d_s$, the subsequent calculations for $A_s$ are exactly the same as previously defined for the Rectangular section design. However, in that case, the width of the beam is taken as $b_w$, as shown in Figure 3-8. Compression reinforcement is required if $a > a_{\text{max}}$.

- If $a > d_s$, the calculation for $A_s$ has two parts. The first part is for balancing the compressive force from the flange, $C_f$, and the second part is for balancing the compressive force from the web, $C_w$, as shown in Figure 3-8. $C_f$ is given by:

$$C_f = 0.85 f_{cd} (b_f - b_w) \times \min(d_s, a_{\text{max}})$$  \hspace{1cm} (TS 7.1)

Therefore, $A_{sf} = \frac{C_f}{f_{yd}}$ and the portion of $M_d$ that is resisted by the flange is given by:

$$M_{df} = C_f \left( d - \frac{\min(d_s, a_{\text{max}})}{2} \right)$$
Therefore, the balance of the moment, $M_{dw}$, to be carried by the web is given by:

$$M_{dw} = M_d - M_{df}$$

The web is a rectangular section of dimensions $b_w$ and $d$, for which the design depth of the compression block is recalculated as:

$$a_1 = d - \sqrt{d^2 - \frac{2M_{dw}}{0.85 f_{cd} b_w}}$$

(TS 7.1)

- If $a_1 \leq a_{\text{max}}$ (TS 7.1), the area of tensile steel reinforcement is then given by:

$$A_{s1} = \frac{M_{dw}}{f_{yd} \left(d - \frac{a_1}{2}\right)}$$

and

$$A_s = A_{s1} + A_{s2}$$

This steel is to be placed at the bottom of the T-beam.

- If $a_1 > a_{\text{max}}$, compression reinforcement is required and is calculated as follows:

The compression force in the web concrete alone is given by:

$$C = 0.85 f_{cd} b_w a_{\text{max}}$$

(TS 7.1)

Therefore the moment resisted by the concrete:

$$M_{dc} = C \left(d - \frac{a_{\text{max}}}{2}\right)$$

The tensile steel for balancing compression in the web concrete is:

$$A_{s2} = \frac{M_{dc}}{f_{yd} \left(d - \frac{a_{\text{max}}}{2}\right)}$$

The moment resisted by compression steel and tensile steel is:
\[ M_{ds} = M_{dw} - M_{dc} \]

Therefore, the compression steel is computed as:

\[ A'_s = \frac{M_{ds}}{\left(\sigma'_s - 0.85 f_{cd}\right)\left(d - d''\right)} \], where

\[ \sigma'_s = E_s \varepsilon_{ct} \left[\frac{c_{\text{max}} - d'}{c_{\text{max}}}\right] \leq f_{yd} \], and

(TS 7.1)

the tensile steel for balancing the compression steel is:

\[ A_{s3} = \frac{M_{ds}}{f_{yd} \left(d - d''\right)} \]

The total tensile reinforcement is \( A_s = A_{s1} + A_{s2} + A_{s3} \), and the total compression reinforcement is \( A'_s \). \( A_s \) is to be placed at the bottom and \( A'_s \) is to be placed at the top.

### 3.6.1.2.3 Minimum and Maximum Tensile Reinforcement

The minimum flexural tensile steel required in a beam section is given by the minimum of the following two limits:

\[ A_s \geq \frac{0.8 f_{cd} b_s d}{f_{yd}} \]  

(TS 7.3, Eqn. 7.3)

The maximum flexural tensile steel required in a beam section is given by the following limit:

\[ A_s - A'_s \leq 0.85 \rho_b b d \]

An upper limit of 0.02 times the gross web area on both the tension reinforcement and the compression reinforcement is imposed as follows:

\[ A_s \leq \begin{cases} 0.02 b d & \text{Rectangular Beam} \\ 0.02 b_e d & \text{T-Beam} \end{cases} \]
### 3.6.1.2.4 Special Consideration for Seismic Design

For High Ductility and Nominal Ductility Resisting concrete frames (seismic design), the beam design satisfies the following additional conditions (see also Table 3-1):

#### Table 3-1: Design Criteria

<table>
<thead>
<tr>
<th>Type of Check/Design</th>
<th>Ordinary Moment Resisting Frames (Non-Seismic)</th>
<th>Nominal Ductility Moment Resisting Frames (Seismic)</th>
<th>High Ductility Moment Resisting Frames (Seismic)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Check (interaction)</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
</tr>
<tr>
<td>Column Design (interaction)</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
</tr>
<tr>
<td>$1% &lt; \rho &lt; 4%$</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
</tr>
<tr>
<td>Beam Design Flexure</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
<td>Specified Combinations</td>
</tr>
<tr>
<td>$\rho \leq 0.02$</td>
<td>$\rho \leq 0.02$</td>
<td>$\rho \leq 0.02$</td>
<td>$\rho \geq \frac{0.8f_{cd}}{f_{yd}}$</td>
</tr>
</tbody>
</table>
Table 3-1: Design Criteria

<table>
<thead>
<tr>
<th>Type of Check/Design</th>
<th>Nominal Ductility Moment Resisting Frames (Non-Seismic)</th>
<th>High Ductility Moment Resisting Frames (Seismic)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinary Moment Resisting Frames (Non-Seismic)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beam Minimum Moment Override Check</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Requirement</td>
<td>( M_{d, \text{end}} \geq \frac{1}{2} M_{d, \text{end}} ) zone 1, 2</td>
<td>( M_{d, \text{end}} \geq \frac{1}{2} M_{d, \text{end}} ) zone 1, 2</td>
</tr>
<tr>
<td></td>
<td>( M_{d, \text{end}} \geq 0.3 M_{d, \text{end}} ) zone 3, 4</td>
<td>( M_{d, \text{end}} \geq 0.3 M_{d, \text{end}} ) zone 3, 4</td>
</tr>
<tr>
<td></td>
<td>( M_{d, \text{span}} \geq \frac{1}{4} \max \left{ M_{d, \text{end}} \right} )</td>
<td>( M_{d, \text{span}} \geq \frac{1}{4} \max \left{ M_{d, \text{end}} \right} )</td>
</tr>
<tr>
<td></td>
<td>( M_{d, \text{span}} \geq \frac{1}{4} \max \left{ M_{d, \text{end}} \right} ) max</td>
<td>( M_{d, \text{span}} \geq \frac{1}{4} \max \left{ M_{d, \text{end}} \right} ) max</td>
</tr>
</tbody>
</table>

Beam Design Shear

<table>
<thead>
<tr>
<th>Specified Combinations</th>
<th>Specified Combinations</th>
<th>Specified Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam Capacity Shear ( (V_c) ) plus ( F_{rel} ) ( V_c = 0 ) (conditional)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Joint Design

<table>
<thead>
<tr>
<th>No Requirement</th>
<th>No Requirement</th>
<th>To be checked for shear</th>
</tr>
</thead>
</table>

Beam/Column Capacity Ratio

<table>
<thead>
<tr>
<th>No Requirement</th>
<th>No Requirement</th>
<th>To be checked for shear</th>
</tr>
</thead>
</table>

- The minimum longitudinal refers to tension reinforcement. Longitudinal reinforcement shall be provided at both the top and bottom. Any of the top and bottom reinforcement shall not be less than \( A_{s,(\min)} \) (TS 7.3).

\[
A_s \geq A_{s,(\min)} = \frac{0.8 \cdot f_{cd} \cdot b_n \cdot d}{f_y d} \text{ or } \quad (TS 7.3)
\]

- The beam flexural steel is limited to a maximum given by

\[
A_i \leq 0.02 b_n d. \quad (TS 7.3)
\]

- At any end (support) of the beam, the beam positive moment capacity (i.e., associated with the bottom steel) would not be less than 50 percent of the beam negative moment capacity (i.e., associated with the top steel) at that end (EDP)
3.4.2.3) in zone 1 and 2 and 30 percent of the beam negative moment capacity in zone 3 and 4.

- Neither the negative moment capacity nor the positive moment capacity at any of the sections within the beam would be less than 1/4 of the maximum of positive or negative moment capacities of any of the beam end (support) stations (EDP 3.4.3.1a).

### 3.6.2 Design Beam Shear Reinforcement

The shear reinforcement is designed for each design load combination at a user-defined number of stations along the beam span. The following steps are involved in designing the shear reinforcement for a particular station because of beam major shear:

- Determine the factored shear force, $V_d$.
- Determine the shear force, $V_c$, that can be resisted by the concrete.
- Determine the reinforcement steel required to carry the balance.

For high ductility moment frames, the shear design of the beams is also based on the maximum probable moment strengths and the nominal moment strengths of the members, respectively, in addition to the factored design. Effects of axial forces on the beam shear design are neglected.

The following three sections describe in detail the algorithms associated with this process.

#### 3.6.2.1 Determine Shear Force and Moment

- In the design of the beam shear reinforcement of nominal ductility concrete frame, the shear forces and moments for a particular design load combination at a particular beam section are obtained by factoring the associated shear forces and moments with the corresponding design load combination factors.

- In the design of High Ductility Moment Resisting concrete frames (i.e., seismic design), the shear capacity of the beam is also checked for the capacity shear resulting from the maximum probable moment strength at the ends along with the factored gravity load. This check is performed in addition to the de-
sign check required for Ordinary moment resisting frames. The capacity shear force, $V_p$, is calculated from the maximum probable moment strength of each end of the beam and the gravity shear forces. The procedure for calculating the design shear force in a beam from the maximum probable moment strength is the same as that described for a column earlier in this chapter. See Table 3-1 for a summary.

The design shear force is then given by (EDP 3.4.5.3):

$$V_d = \max \{V_{e1}, V_{e2}\}$$

(EDP 3.4.5.3, Fig 3.9)

$$V_{e1} = V_p + V_{G+Q}$$

(EDP 3.4.5.3, Fig 3.9)

$$V_{e2} = V_p + V_{G+Q}$$

(EDP 3.4.5.3, Fig 3.9)

where $V_p$ is the capacity shear force obtained by applying the calculated maximum probable ultimate moment capacities at the two ends of the beams acting in two opposite directions. Therefore, $V_p$ is the maximum of $V_{p1}$ and $V_{p2}$, where

$$V_{p1} = \frac{M_I^+ + M_J^-}{L}, \quad \text{and}$$

$$V_{p2} = \frac{M_I^- + M_J^+}{L}, \quad \text{where}$$

$M_I^+$ = Moment capacity at end I, with top steel in tension, using a steel yield stress $f_{yd}$ and a concrete stress $f_{cd}$.

$M_J^+$ = Moment capacity at end J, with bottom steel in tension, using a steel yield stress $f_{yd}$ and a concrete stress $f_{cd}$.

$M_I^-$ = Moment capacity at end I, with bottom steel in tension, using a steel yield stress $f_{yd}$ and a concrete stress $f_{cd}$.

$M_J^-$ = Moment capacity at end J, with top steel in tension, using a steel yield stress $f_{yd}$ and a concrete stress $f_{cd}$.

$L$ = Clear span of beam.
Chapter 3 - Design Process

If the reinforcement area has not been overwritten for ductile beams, the value of the reinforcing area envelope is calculated after completing the flexural design of the beam for all the design load combinations. Then this enveloping reinforcing area is used in calculating the moment capacity of the beam. If the reinforcing area has been overwritten for ductile beams, this area is used in calculating the moment capacity of the beam. If the beam section is a variable cross-section, the cross-sections at the two ends are used along with the user-specified reinforcing or the envelope of reinforcing, as appropriate. If the user overwrites the major direction length factor, the full span length is used. However, if the length factor is not overwritten, the clear length will be used. In the latter case, the maximum of the negative and positive moment strengths will be used in determining the capacity shear.

\[ V_{G+Q} \] is the contribution of shear force from the in-span distribution of gravity loads with the assumption that the ends are simply supported.

The computation of the design shear force in a beam of an Nominal Ductility Moment Resisting Frame is the same as described for columns earlier in this chapter. See Table 3-1 for a summary.

### 3.6.2.2 Determine Concrete Shear Capacity

Given the design force set \( N_d \) and \( V_d \), the shear force carried by the concrete, \( V_{c} \), is calculated as follows:

- If the beam is subjected to axial loading, \( N_d \) is positive in this equation regardless of whether it is a compressive or tensile force,

\[
V_{cr} = 0.65 f_{cd} b_n d \left( 1 + \gamma N_d \frac{A_d}{A_g} \right),
\]

where,

- \( 0.07 \) for axial compression
- \( \gamma = -0.3 \) for axial tension
- \( 0 \) when tensile stress < 0.5 MPa

\[
V_c = 0.8 V_{cr},
\]

(TS 8.1.3, Eqn. 8.1)

(TS 8.1.4, Eqn. 8.4)
For High Ductility Moment Resisting Concrete Frame design, if the factored axial compressive force, \( N_d \), including the earthquake effect, is small \( (N_d < 0.05 f_{ck} A_e) \) and if the shear force contribution from earthquake, \( V_E \), is more than half of the total factored maximum shear force \( V_d (V_E \geq 0.5V_d) \) over the length of the member, and if the station is within a distance \( l_o \) from the face of the joint, then the concrete capacity \( V_c \) is taken as zero (EDP 3.7.6). Note that for capacity shear design, \( V_c \) is considered to be contributed solely by earthquakes, so the second condition is automatically satisfied. The length \( l_o \) is taken as the section width, one-sixth the clear span of the column, or 500 mm, whichever is larger (EDP 3.3.4.1, 3.3.7.6).

### 3.6.2.3 Determine Required Shear Reinforcement

Given \( V_d \) and \( V_c \), the required shear reinforcement in the form of stirrups or ties within a spacing, \( s \), is given for rectangular and circular columns by the following:

- The shear force is limited to a maximum of
  \[
  V_{\text{max}} = 0.22 f_{cd} A_w
  \]
  (TS 8.1.5b, EDP 3.3.7.5)

- The required shear reinforcement per unit spacing, \( A_r / s \), is calculated as follows:
  
  If \( V_d \leq V_{cr} \),
  \[
  \frac{A_{rw}}{s} = 0.3 \frac{f_{cd}}{f_{ywd}} b_w
  \]
  (TS 8.1.5, Eqn. 8.6)

  else if \( V_{cr} < V_d \leq V_{\text{max}} \),
  \[
  \frac{A_{rw}}{s} = \frac{(V_d - V_c)}{f_{ywd} d}
  \]
  (TS 8.1.4, Eqn. 8.5)

  \[
  \frac{A_{rw}}{s} \geq 0.3 \frac{f_{cd}}{f_{ywd}} b_w
  \]
  (TS 8.1.5, Eqn. 8.6)

  else if \( V_d > V_{\text{max}} \),
a failure condition is declared. (TS 8.1.5b)

If $V_d$ exceeds its maximum permitted value $V_{\text{max}}$, the concrete section size should be increased (TS 8.1.5b).

Note that if torsion design is performed and torsion rebar is needed, the equation given in TS 8.1.5 does not need to be satisfied independently. See the next section *Design of Beam Torsion Reinforcement* for details.

The maximum of all of the calculated $A_{sw}/s$ values, obtained from each design load combination, is reported along with the controlling shear force and associated design load combination name.

The beam shear reinforcement requirements reported by the program are based purely on shear strength considerations. Any minimum stirrup requirements to satisfy spacing and volumetric consideration must be investigated independently of the program by the user.

### 3.6.3 Design Beam Torsion Reinforcement

The torsion reinforcement is designed for each design load combination at a user-defined number of stations along the beam span. The following steps are involved in designing the shear reinforcement for a particular station because of beam torsion:

- Determine the factored torsion, $T_d$.
- Determine special section properties.
- Determine critical torsion capacity.
- Determine the reinforcement steel required.

Note that the torsion design can be turned off by choosing not to consider torsion in the Preferences.

#### 3.6.3.1 Determine Factored Torsion

In the design of torsion reinforcement of any beam, the factored torsions for each design load combination at a particular design station are obtained by factoring
the corresponding torsion for different analysis cases with the corresponding
design load combination factors (TS 8.2).

In a statistically indeterminate structure where redistribution of the torsional
moment in a member can occur due to redistribution of internal forces upon
cracking, the design $T_d$ is permitted to be reduced in accordance with code (TS
8.2.3). However, the program does not try to redistribute the internal forces and
to reduce $T_d$. If redistribution is desired, the user should release the torsional
DOF in the structural model.

### 3.6.3.2 Determine Special Section Properties

For torsion design, special section properties such as $A_e$, $S$ and $u_e$ are calculated.
These properties are described as follows (TS 8.2.4).

- $A_e$ = Area enclosed by centerline of the outermost closed transverse
torsional reinforcement
- $S$ = Shape factor for torsion
- $u_e$ = Perimeter of area $A_e$

In calculating the section properties involving reinforcement, such as $A_{ov}/s, A_{ot}/s$, and $u_e$, it is assumed that the distance between the centerline of the outermost
closed stirrup and the outermost concrete surface is 30 mm. This is equivalent to
25-mm clear cover and a 10-mm-diameter stirrup placement. For torsion design
do T beam sections, it is assumed that placing torsion reinforcement in the flange
area is inefficient. With this assumption, the flange is ignored for torsion rein-
forcement calculation. However, the flange is considered during $T_{cr}$ calculation.

With this assumption, the special properties for a Rectangular beam section are
given as follows:

$$A_e = (b - 2c)(h - 2c), \quad (TS \ 8.2.4)$$

$$u_e = 2(b - 2c) + 2(h - 2c), \quad (TS \ 8.2.4)$$

$$S = x^2 y/3 \quad (TS \ 8.2.4)$$

where, the section dimensions $b$, $h$ and $c$ are shown in Figure 3-9. Similarly, the
special section properties for a T beam section are given as follows:
Ae = \left( b_w - 2c \right) \left( h - 2c \right) \quad \text{(TS 8.2.4)}
\]
\[
u_t = 2 \left( h - 2c \right) + 2 \left( b_w - 2c \right) \quad \text{(TS 8.2.4)}
\]
\[
S = \Sigma x^2 y/3 \quad \text{(TS 8.2.4)}
\]

where the section dimensions \( b_w, h \) and \( c \) for a T-beam are shown in Figure 3-9.

### 3.6.3.3 Determine Critical Torsion Capacity

Design for torsion may be ignored if either of the following is satisfied:

(i) The critical torsion limits, \( T_{cr} \), for which the torsion in the section can be ignored, is calculated as follows:

\[
T_d \leq T_{cr} = 0.65 f_{cd} S \quad \text{(TS 8.2.3, Eqn 8.12)}
\]

In that case, the program reports shear reinforcement based on TS 8.1.5, Eqn. 8.6, i.e.,

\[
\frac{A_{cw}}{s} \geq 0.3 \frac{f_{cd}}{f_{ywd}} b_w \quad \text{(TS 8.1.5, Eqn. 8.6)}
\]

(ii) When design shear force and torsional moment satisfy the following equation, there is no need to compute torsional stirrups. However, the minimum stirrups and longitudinal reinforcement shown below must be provided:

\[
\left( \frac{V_d}{V_{cr}} \right)^2 + \left( \frac{T_d}{T_{cr}} \right)^2 \leq 1 \quad \text{(TS 8.2.2, Eqn 8.10)}
\]

where \( T_{cr} \) is computed as follows:

\[
T_{cr} = 1.35 f_{cd} S \quad \text{(TS 8.2.2, Eqn 8.11)}
\]

The required minimum closed stirrup area per unit spacing, \( A_o/s \), is calculated as:

\[
\frac{A_o}{s} = 0.15 \frac{f_{cd}}{f_{ywd}} \left( 1 + \frac{1.3T_d}{V_d b_w} \right) b_w \quad \text{(TS 8.2.4, Eqn. 8.17)}
\]
In Eqn. 8.17, \( \frac{T_d}{V_d b_w} \leq 1.0 \) and for the case of statistically indeterminate structure where redistribution of the torsional moment in a member can occur due to redistribution of internal forces upon cracking, minimum reinforcement will obtained by taking \( T_d \) equal to \( T_{cr} \).

and the required minimum longitudinal rebar area, \( A_{sl} \), is calculated as:

\[
A_{sl} = \frac{T_d u_c}{2A_e f_{yd}} \quad \text{(TS 8.2.5, Eqn. 8.18)}
\]

### 3.6.3.4 Determine Torsion Reinforcement

If the factored torsion \( T_d \) is less than the threshold limit, \( T_{cr} \), torsion can be safely ignored (TS 8.2.3), when the torsion is not required for equilibrium. In that case, the program reports that no torsion is required. However, if \( T_d \) exceeds the threshold limit, \( T_{cr} \), it is assumed that the torsional resistance is provided by closed stirrups, longitudinal bars, and compression diagonals (TS 8.2.4 and 8.2.5).
If $T_d > T_{cr}$, the required longitudinal rebar area, $A_{dl}$, is calculated as:

$$A_{dl} = \frac{T_d u_e}{2 A_c f_y d}$$  
(TS 8.2.4, Eqn. 8.16)

and the required closed stirrup area per unit spacing, $A_{ot}/s$, is calculated as:

$$\frac{A_o}{s} = \frac{A_{ov}}{s} + \frac{A_{at}}{s}$$  
(TS 8.2.4, Eqn. 8.13)

$$\frac{A_{ov}}{s} = \frac{(V_a - V_c)}{d f_{ywd}}$$  
(TS 8.2.4, Eqn. 8.14)

$$\frac{A_{ot}}{s} = \frac{T_d}{2 A_c f_{ywd}}$$  
(TS 8.2.4, Eqn. 8.15)

where, the minimum value of $A_o/s$ is taken as:

$$\frac{A_o}{s} = 0.15 \frac{f_{cd}}{f_{ywd}} \left(1 + \frac{1.3 T_d}{V_d b_w} \right) b_w$$  
(TS 8.2.4, Eqn. 8.17)

where, $\frac{1.3 T_d}{V_d b_w} \leq 1.0$

An upper limit of the combination of $V_d$ and $T_d$ that can be carried by the section also is checked using the following equation.

$$\frac{T_d}{S} + \frac{V_d}{b_v d} \leq 0.22 f_{cd}$$  
(TS 8.2.5b, Eqn. 8.19)

The maximum of all the calculated $A_{dl}$ and $A_o/s$ values obtained from each design load combination is reported along with the controlling combination names.

The beam torsion reinforcement requirements reported by the program are based purely on strength considerations. Any minimum stirrup requirements and longitudinal rebar requirements to satisfy spacing considerations must be investigated independently of the program by the user.
3.7 Joint Design

To ensure that the beam-column joint of High Ductility Moment Resisting Frames possesses adequate shear strength, the program performs a rational analysis of the beam-column panel zone to determine the shear forces that are generated in the joint. The program then checks this against design shear strength.

Only joints having a column below the joint are checked. The material properties of the joint are assumed to be the same as those of the column below the joint.

The joint analysis is completed in the major and the minor directions of the column. The joint design procedure involves the following steps:

- Determine the panel zone design shear force, $V_{e}^h$
- Determine the effective area of the joint
- Check panel zone shear stress

The algorithms associated with these three steps are described in detail in the following three sections.

3.7.1 Determine the Panel Zone Shear Force

Figure 3-10 illustrates the free body stress condition of a typical beam-column intersection for a column direction, major or minor.

The force $V_{e}^h$ is the horizontal panel zone shear force that is to be calculated. The forces that act on the joint are $N_d$, $V_{kol}$, $M_{d}^l$, and $M_{d}^R$. The forces $N_d$ and $V_{kol}$ are axial force and shear force, respectively, from the column framing into the top of the joint. The moments $M_{d}^l$ and $M_{d}^R$ are obtained from the beams framing into the joint. The program calculates the joint shear force $V_{e}^h$ by resolving the moments into $C$ and $T$ forces. Noting that $T_L = C_L$ and $T_R = C_R$,

$$V_{e}^h = T_L + T_R - V_{kol}$$
Figure 3-10 Beam-column joint analysis

Note:
The values of $N_i$, $M_i$, and $W_i$ for CASE 1 are not necessarily the same as those for CASE 2.
The location of \( C \) or \( T \) forces is determined by the direction of the moment. The magnitude of \( C \) or \( T \) forces is conservatively determined using basic principles of ultimate strength theory (TS 7.1).

The moments and the forces from beams that frame into the joint in a direction that is not parallel to the major or minor direction of the column are resolved along the direction that is being investigated, thereby contributing force components to the analysis.

In the design of Highly Ductile Moment Resisting concrete frames, the evaluation of the design shear force is based on the moment capacities (with reinforcing steel overstrength factor, \( \alpha \), where, \( \alpha = 1.25 \)) of the beams framing into the joint (EDP 3.5.2.1). The \( C \) and \( T \) force are based on these moment capacities. The program calculates the column shear force \( V_{kot} \) from the beam moment capacities, as follows (see Figure 3-5):

\[
V_{kot} = \frac{M^L + M^B}{H}
\]

It should be noted that the points of inflection shown on Figure 3-5 are taken as midway between actual lateral support points for the columns. If no column exists at the top of the joint, the shear force from the top of the column is taken as zero.

The effects of load reversals, as illustrated in Case 1 and Case 2 of Figure 3-10, are investigated and the design is based on the maximum of the joint shears obtained from the two cases.

### 3.7.2 Determine the Effective Area of Joint

The joint area that resists the shear forces is assumed always to be rectangular in plan view. The dimensions of the rectangle correspond to the major and minor dimensions of the column below the joint, except if the beam framing into the joint is very narrow. The effective width of the joint area to be used in the calculation is limited to the width of the beam plus the depth of the column. The area of the joint is assumed not to exceed the area of the column below. The joint area for joint shear along the major and minor directions is calculated separately (EDP 3.5.1).
It should be noted that if the beam frames into the joint eccentrically, the preceding assumptions may not be conservative and the user should investigate the acceptability of the particular joint.

### 3.7.3 Check Panel Zone Shear Stress

The panel zone shear stress is evaluated by dividing the shear force by the effective area of the joint and comparing it with the following design shear strengths (EDP 3.5.2.2).

\[
v = \begin{cases} 
0.60 f_{cd} & \text{for joints confined on all four sides,} \\
0.45 f_{cd} & \text{for all other joints}
\end{cases} 
\]  

(EDP 3.5.2.2)

A beam that frames into a face of a column at the joint is considered in this program to provide confinement to the joint if at least three-quarters of the face of the joint is covered by the framing member (EDP 3.5.2.2).

For joint design, the program reports the joint shear, the joint shear stress, the allowable joint shear stress, and a capacity ratio.

### 3.7.4 Beam-Column Flexural Capacity Ratios

The program calculates the ratio of the sum of the beam moment capacities to the sum of the column moment capacities. For high ductility frames, at a particular joint for a particular column direction, major or minor (EDP 3.3.5):

\[
\sum M_{rc} \geq \frac{6}{5} \sum M_{rb} 
\]  

(EDP 3.3.5)

- \( \sum M_{rc} \) = Sum of probable flexural strengths of columns framing into the joint, evaluated at the faces of the joint. Individual column flexural strength is calculated for the associated factored axial force.

- \( \sum M_{rb} \) = Sum of probable flexural strengths of the beams framing into the joint, evaluated at the faces of the joint.
The beam capacities are calculated for reversed situations (Cases 1 and 2) as illustrated in Figure 3-10 and the maximum summation obtained is used.

The moment capacities of beams that frame into the joint in a direction that is not parallel to the major or minor direction of the column are resolved along the direction that is being investigated and the resolved components are added to the summation.

The column capacity summation includes the column above and the column below the joint. For each load combination, the axial force, $N_d$, in each of the columns is calculated from the program design load combinations. For each design load combination, the moment capacity of each column under the influence of the corresponding axial load is then determined separately for the major and minor directions of the column, using the uniaxial column interaction diagram; see Figure 3-11. The moment capacities of the two columns are added to give the capacity summation for the corresponding design load combination. The maximum capacity summations obtained from all of the design load combinations is used for the beam-column capacity ratio.

The beam-column capacity ratio is determined for a beam-column joint only when the following conditions are met:

- the frame is a High Ductility moment resisting frame
- when a column exists above the beam-column joint, the column is concrete
- all of the beams framing into the column are concrete beams
- the connecting member design results are available
- the load combo involves seismic load

The beam-column flexural capacity ratios ($\sum M_\alpha / \sum M_\alpha$) are reported only for high ductility frames involving seismic design load combinations. If this ratio is greater than 5/6, a warning message is printed in the output. The ratio is also reported in the form of $\left( \frac{6}{5} \right) \sum M_{rb} / M_{rc}$ and $\sum M_{rc} / \sum M_{rb}$.
Figure 3-11 Moment capacity $M_d$ at a given axial load $N_d$
4.1 Overview

The program creates design output in different formats – graphical display, tabular output, and member specific detailed design information.

The graphical display of design output includes input and output design information. Input design information includes design section labels, $K$-factors, live load reduction factors, and other design parameters. The output design information includes longitudinal reinforcing, shear reinforcing, torsional reinforcing and column capacity ratios. All graphical output can be printed.

The tabular output can be saved in a file or printed. The tabular output includes most of the information that can be displayed. This is generated for added convenience to the designer.

The member specific detailed design information shows the details of the calculation from the designer’s point of view. It shows the design forces, design section dimensions, reinforcement, and some intermediate results for all of the load combinations at all of the design sections of a specific frame member. For a column member, it also can show the position of the current state of design forces on the column interaction diagram.
In the following sections, some of the typical graphical display, tabular output, spreadsheet output, and member specific detailed design information are described. The TS 500-2000 design code is described in this manual.

### 4.2 Graphical Display of Design Information

The graphical display of design output includes input and output design information. Input design information includes design section label, \( K \)-factors, live load reduction factor, and other design parameters. The output design information includes longitudinal reinforcing, shear reinforcing, torsion reinforcing, column capacity ratio, beam-column capacity ratio, joint shear check, and other design information.

The graphical output can be produced in color or in gray-scaled screen display. The active screen display can be sent directly to the printer.

#### 4.2.1 Input and Output

Input design information for the TS 500-2000 code includes the following:

- Design sections
- Design framing type
- Live load reduction factors (RLLF)
- Unbraced length, \( L \)-factors, for major and minor direction of bending
- Effective length factors, \( K \)-factors, for major and minor direction of bending
- \( C_m \) factors, for major and minor direction of bending
- \( \beta_{ns} \) factors, for major and minor direction of bending
- \( \beta_s \) factors, for major and minor direction of bending

The output design information that can be displayed consists of the following:

- Longitudinal reinforcing area
- Longitudinal reinforcing area as percent of concrete gross area
Chapter 4 - Design Output

- Shear reinforcing areas per unit spacing
- Column P-M-M interaction ratios
- $\delta \frac{6}{3}$ Beam-column capacity ratios
- Column-beam capacity ratios
- Joint shear capacity ratios
- Torsion reinforcing
- General reinforcing details

Use the **Design menu > Concrete Frame Design > Display Design Info** command in the program to plot input and output values directly on the model in the active window. Clicking this command will access the Display Design Results form. Select the Design Output or Design Input option, and then use the drop-down lists to choose the type of design data to be displayed, such as longitudinal reinforcement, rebar percentages, shear reinforcing and so on. Click the **OK** button on the form to close the form and display the selected data in the active window.

The graphical displays can be viewed in 2D or 3D mode. Use the various toolbar buttons (e.g., **Set Default 3D View, Set X-Y View**) to adjust the view, or use the **View menu > Set 2D View** or **View menu > Set 3D View** commands in program and the **Home > View > Set 2D View** to refine the display.

The graphical display in the active window can be printed by clicking the **File menu > Print Graphics** command in the program, the **Print Graphics** button on the toolbar, or the Ctrl+G keyboard shortcut. The display also can be captured as a bit map file (.bmp) using one of the subcommands on the **File menu > Capture Picture** command in the program, or as a metafile (.emf) using one of the subcommands on the **File menu > Capture Enhanced Metafile** command. The captured picture file can then be used in popular graphics programs, including Paint and PowerPoint. Alternatively, the standard Windows screen capture command (click the **Print Screen** button on the keyboard) can be used to create a screen capture of the entire window, or use the **Alt+Print Screen** command to capture only the "top layer," such as a form displayed from within the program.
By default, graphics are displayed and printed in color, assuming a color printer is available. Use the Options menu > Colors > Output command to change default colors, as necessary, including changing the background color from the default black to white. A white background can be useful when printing design output to save ink/toner. In addition, the Options menu > Colors > Set Active Theme command can be used to view or print graphics in grayscale in the program.

4.3 Tabular Display of Design Output

The tabular design output can be sent directly to a printer or saved to a file. The printed form of the tabular output is the same as that produced for the file output except that the font size is adjusted for the printed output.

The tabular design output includes input and output design information that depends on the design code chosen. For the TS 500-2000 code, the tabular output includes the following. All tables have formal headings and are self-explanatory, so further description of these tables is not given.

Input design information includes the following:

- Concrete Column Property Data
  - Material label
  - Column dimensions
  - Reinforcement pattern
  - Concrete cover
  - Bar area

- Concrete Beam Property Data
  - Material label
  - Beam dimensions
  - Top and bottom concrete cover
  - Top and bottom reinforcement areas

- Load Combination Multipliers
  - Combination name
  - Load types
  - Load factors
Chapter 4 - Design Output

- Concrete Design Element Information
  - Design section ID
  - Factors for major and minor direction of bending
  - Unbraced length ratios for major and minor direction of bending, \( L \)-factors
  - Live load reduction factors (RLLF)

- Concrete Moment Magnification Factors
  - Section ID
  - Element type
  - Framing type
  - \( \beta_{ns} \)-factors
  - \( \beta_s \)-factors

The output design information includes the following:

- Column Design Information
  - Section ID
  - Station location
  - Total longitudinal reinforcement and the governing load combination
  - Major shear reinforcement and the governing load combination
  - Minor shear reinforcement and the governing load combination

- Beam Design Information
  - Section ID
  - Station location
  - Top longitudinal reinforcement and the governing load combination
  - Bottom reinforcement and the governing load combination
  - Longitudinal torsional reinforcement and the governing load combination
  - Major shear reinforcement and the governing load combination for shear and torsion design

- Concrete Column Joint Information
  - Section ID
  - (6/5) Beam/column capacity ratios for major and minor direction and the governing load combination
  - Joint shear capacity for major and minor direction and the governing load combination
Tabular output can be printed directly to a printer or saved in a file using the **File menu > Print Tables** command. A form will display when this command is used. Depress the F1 key on the keyboard to access the Help topic specific to that form, which will identify the types of output available (e.g., plain text with or without page breaks, rich text format Word document, and so on).

### 4.4 Member Specific Information

Member specific design information shows the details of the calculation from the designer’s point of view. It includes the geometry and material data, other input data, design forces, design section dimensions, reinforcement details, and some of the intermediate results for the selected member. The design detail information can be displayed for a specific load combination and for a specific station of a column or beam member. For columns, member specific design information also can show the position of the current state of design forces using a column interaction diagram.

After an analysis has been performed and the **Design menu > Concrete Frame Design > Start Design/Check** command has been used, access the detailed design information by right clicking a frame member to display the Concrete Column Design Information form if a column member was right clicked or the Concrete Beam Design Information form if a beam member was right clicked. Table 4-1 identifies the types of data provided by the forms.

The longitudinal and shear reinforcing area are reported in their current units, which are displayed in the drop-down list in the lower right corner of the program window. Typically, the longitudinal reinforcing area is reported in $\text{in}^2$, $\text{mm}^2$, $\text{cm}^2$ and so on. Shear reinforcing areas typically are reported in $\text{in}^2/\text{in}$, $\text{mm}^2/\text{mm}$, $\text{cm}^2/\text{cm}$ and so on.

<table>
<thead>
<tr>
<th>Table 4-1 Member Specific Data for Columns and Beams</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>- Load combination ID</td>
</tr>
<tr>
<td>- Station locations</td>
</tr>
<tr>
<td>- Longitudinal reinforcement area</td>
</tr>
<tr>
<td>- Major shear reinforcement areas</td>
</tr>
</tbody>
</table>

---

**4 - 6 Member Specific Information**
### Table 4-1 Member Specific Data for Columns and Beams

<table>
<thead>
<tr>
<th>Minor shear reinforcement areas</th>
<th>Longitudinal reinforcement for torsion design</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Shear reinforcement area for shear</td>
</tr>
<tr>
<td></td>
<td>Shear reinforcement area for torsion design</td>
</tr>
</tbody>
</table>

Buttons on the forms can be used to access additional forms that provide the following data

- **Overwrites**
  - Element section ID
  - Element framing type
  - Live load reduction factors
  - Effective length factors, \( K \), for major and minor direction bending
  - \( C_m \) factors for major and minor bending
  - \( \beta_i \) factors for major and minor directions

- **Summary design data**
  - Geometric data and graphical representation
  - Material properties
  - Minimum design moments
  - Moment factors
  - Longitudinal reinforcing areas
  - Design shear forces
  - Shear reinforcing areas
  - Shear capacities of steel and concrete
  - Torsion reinforcing
  - Interaction diagram, with the axial force and biaxial moment showing the state of stress in the column

- **Detailed calculations for flexural details, shear details, joint shear, and beam/column capacity ratios**

<table>
<thead>
<tr>
<th>Overwrites</th>
<th>Summary design data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Geometric data and graphical representation</td>
</tr>
<tr>
<td></td>
<td>Material properties</td>
</tr>
<tr>
<td></td>
<td>Design moments and shear forces</td>
</tr>
<tr>
<td></td>
<td>Minimum design moments</td>
</tr>
<tr>
<td></td>
<td>Top and bottom reinforcing areas</td>
</tr>
<tr>
<td></td>
<td>Shear capacities of concrete and steel</td>
</tr>
<tr>
<td></td>
<td>Shear reinforcing area</td>
</tr>
<tr>
<td></td>
<td>Torsion reinforcing area</td>
</tr>
</tbody>
</table>

The load combination is reported by its name, while station data is reported by its location as measured from the I-end of the column. The number of line items reported is equal to the number of design combinations multiplied by the number of stations. One line item will be highlighted when the form first displays. This line item will have the largest required longitudinal reinforcing, unless any design overstress or error occurs for any of the items. In that case, the last item among the overstressed items or items with errors will be highlighted. In essence, the program highlights the critical design item.

If a column has been selected and the column has been specified to be checked by the program, the form includes the same information as that displayed for a designed column, except that the data for a checked column includes the ca-
capacity ratio rather than the total longitudinal reinforcing area. Similar to the
design data, the line item with the largest capacity ratio is highlighted when the
form first displays, unless an item has an error or overstress, in which case, that
item will be highlighted. In essence, the program highlights the critical check
item.

The program can be used to check and to design rebar in a column member.
When the users specifies that the program is to check the rebar in the column, the
program checks the rebar as it is specified. When the user specifies that the
program design the rebar configuration, the program starts with the data speci-
fied for rebar and then increases or decreases the rebar in proportion to the rel-
ative areas of rebar at the different locations of rebar in the column.

4.4.1 Interactive Concrete Frame Design

The interactive concrete frame design and review is a powerful mode that allows
the user to review the design results for any concrete frame design, to revise the
design assumptions interactively, and to review the revised results immediately.

Before entering the interactive concrete frame design mode, the design results
must be available for at least one member. That means the design must have
been run for all the members or for only selected members. If the initial design
has not been performed yet, run a design by clicking the Design menu > Con-
crete Frame Design > Start Design/Check of Structure.

There are three ways to initiate the interactive concrete frame design mode:

- Click the Design menu > Concrete Frame Design > Start Design/Check
  of Structures command to run a design.
- Click the Design menu > Concrete Frame Design > Display Design Info
  command to access the Display Design Results form and select a type of
  result.
- Click the Design menu > Concrete Frame Design > Interactive Concrete
  Frame Design command.

After using any of the three commands, right click on a frame member to enter
the interactive Concrete Frame Design Mode and access the Concrete Column
Design Information form if a column member was right clicked or the Concrete
Beam Design Information form if a beam member was right clicked. These forms have **Overwrites** buttons that accesses the Concrete Frame Design Overwrites form. The form can be used to change the design sections, element type, live load reduction factor for reducible live load, and many other design factors. See Appendix D for a detailed description of the overwrite items. When changes to the design parameters are made using the Overwrites form, the Concrete Beam or Column Design Information forms update immediately to reflect the changes. Then other buttons on the Concrete Beam or Column Design Information forms can be used to display additional forms showing the details of the updated design. See the *Member Specific Information* section of this chapter for more information.

In this way, the user can change the overwrites any number of times to produce a satisfactory design. After an acceptable design has been produced by changing the section or other design parameters, click the **OK** button on the Concrete Beam or Column Design Information forms to permanently change the design sections and other overwrites for that member. However, if the **Cancel** button is used, all changes made to the design parameters using the Concrete Frame Design Overwrites form are temporary and do not affect the design.

### 4.5 Error Messages and Warnings

In many places of concrete frame design output, error messages and warnings are displayed. The messages are numbered. A complete list of error messages and warnings used in Concrete Frame Design for all the design codes is provided in Appendix E. However, all of the messages are not applicable to TS 500-2000 code.
Appendix A
Second Order P-Delta Effects

Typically, design codes require that second order P-Delta effects be considered when designing concrete frames. These effects are the global lateral translation of the frame and the local deformation of members within the frame.

Consider the frame object shown in Figure A-1, which is extracted from a story level of a larger structure. The overall global translation of this frame object is indicated by $\Delta$. The local deformation of the member is shown as $\delta$. The total second order P-Delta effects on this frame object are those caused by both $\Delta$ and $\delta$.

The program has an option to consider P-Delta effects in the analysis. When P-Delta effects are considered in the analysis, the program does a good job of capturing the effect due to the $\Delta$ deformation shown in Figure A-1, but it does not typically capture the effect of the $\delta$ deformation (unless, in the model, the frame object is broken into multiple elements over its length).

Consideration of the second order P-Delta effects is generally achieved by computing the flexural design capacity using a formula similar to that shown in the following equation.
Figure A-1 The total second order P-delta effects on a frame element caused by both \( \Delta \) and \( \delta \)

\[
M_{\text{CAP}} = aM_{\text{nt}} + bM_{\text{lt}}
\]

where,

- \( M_{\text{CAP}} \) = Flexural design capacity required
- \( M_{\text{nt}} \) = Required flexural capacity of the member assuming there is no joint translation of the frame (i.e., associated with the \( \delta \) deformation in Figure A-1)
- \( M_{\text{lt}} \) = Required flexural capacity of the member as a result of lateral translation of the frame only (i.e., associated with the \( \Delta \) deformation in Figure A-1)
- \( a \) = Unitless factor multiplying \( M_{\text{nt}} \)
- \( b \) = Unitless factor multiplying \( M_{\text{lt}} \) (assumed equal to 1 by the program; see the following text)

When the program performs concrete frame design, it assumes that the factor \( b \) is equal to 1 and calculates the factor \( a \). That \( b = 1 \) assumes that P-Delta effects have been considered in the analysis, as previously described. Thus, in general, when performing concrete frame design in this program, consider P-Delta effects in the analysis before running the program.
The column unsupported lengths are required to account for column slenderness effects. The program automatically determines the unsupported length ratios, which are specified as a fraction of the frame object length. Those ratios times the frame object length give the unbraced lengths for the members. Those ratios also can be overwritten by the user on a member-by-member basis, if desired, using the overwrite option.

There are two unsupported lengths to consider. They are $l_{33}$ and $l_{22}$, as shown in Figure B-1. These are the lengths between support points of the member in the corresponding directions. The length $l_{33}$ corresponds to instability about the 3-3 axis (major axis), and $l_{22}$ corresponds to instability about the 2-2 axis (minor axis).

In determining the values for $l_{22}$ and $l_{33}$ of the members, the program recognizes various aspects of the structure that have an effect on those lengths, such as member connectivity, diaphragm constraints and support points. The program automatically locates the member support points and evaluates the corresponding unsupported length.
It is possible for the unsupported length of a frame object to be evaluated by the program as greater than the corresponding member length. For example, assume a column has a beam framing into it in one direction, but not the other, at a floor level. In that case, the column is assumed to be supported in one direction only at that story level, and its unsupported length in the other direction will exceed the story height.

*Figure B-1 Axis of bending and unsupported length*
Appendix C
Concrete Frame Design Preferences

The concrete frame design preferences are general assignments that are applied to all of the concrete frame members. The design preferences should be reviewed and any changes from the default values made before performing a design. The following table lists the design preferences that are specific to using TS 500-2000; the preferences that are generic to all codes are not included in this table.

Table C-1 Preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Possible Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-Response Case Design</td>
<td>Envelopes, Step-by-Step, Last Step, Envelopes – All, Step-by-Step - All</td>
<td>Envelopes</td>
<td>Toggle for design load combinations. This is either &quot;Envelopes&quot;, &quot;Step-by-Step&quot;, &quot;Last Step&quot;, &quot;Envelopes - All&quot;, &quot;Step-by-Step - All&quot; indicating how results for multivalued cases (Time history, Nonlinear static or Multi-step static) are considered in the design. If a single design load combination has more than one time history, Nonlinear static or Multi-step static case in it, that design load combination is designed for the envelopes of the</td>
</tr>
<tr>
<td>Item</td>
<td>Possible Values</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>concrete Frame Design TS 500-2000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>time histories, regardless of what is specified here.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number Interaction Curves</td>
<td>Multiple of 4</td>
<td>24</td>
<td>Number of equally spaced interaction curves used to create a full 360 deg interaction surface (this item should be a multiple of four). We recommend 24 for this item.</td>
</tr>
<tr>
<td>Number</td>
<td>Any odd value</td>
<td>11</td>
<td>Number of points used for defining a single curve in a concrete frame; should be odd.</td>
</tr>
<tr>
<td>Consider Minimum Eccentricity</td>
<td>No, Yes</td>
<td>Yes</td>
<td>Toggle to specify if minimum eccentricity is considered in design.</td>
</tr>
<tr>
<td>Seismic Zone</td>
<td>Zone 1, Zone 2, Zone 3, Zone 4</td>
<td>Zone 4</td>
<td>This item varies with the Seismic Zone for detailing.</td>
</tr>
<tr>
<td>Gamma (Steel)</td>
<td>&gt; 0</td>
<td>1.15</td>
<td>Material factor for reinforcing steel.</td>
</tr>
<tr>
<td>Gamma (Concrete)</td>
<td>&gt; 0</td>
<td>1.5</td>
<td>Material factor for concrete.</td>
</tr>
<tr>
<td>Gamma (Concrete Shear)</td>
<td>&gt; 0</td>
<td>1.25</td>
<td>Material factor for concrete shear strength.</td>
</tr>
<tr>
<td>Pattern Load Factor</td>
<td>≥ 0</td>
<td>0.75</td>
<td>The pattern load factor is used to compute positive live load moment by multiplying Live load with Pattern Load Factor (PLF) and assuming that beam is simply supported. This option provides a limited pattern loading to frames. Use zero to turn off this option.</td>
</tr>
<tr>
<td>Utilization Factor Limit</td>
<td>&gt; 0</td>
<td>0.95</td>
<td>Stress ratios that are less than or equal to this value are considered acceptable.</td>
</tr>
</tbody>
</table>
The concrete frame design overwrites are basic assignments that apply only to those elements to which they are assigned. Table D-1 lists concrete frame design overwrites for TS 500-2000. Default values are provided for all overwrite items. Thus, it is not necessary to specify or change any of the overwrites. However, at least review the default values to ensure they are acceptable. When changes are made to overwrite items, the program applies the changes only to the elements to which they are specifically assigned.

Table D-1 Overwrites

<table>
<thead>
<tr>
<th>Item</th>
<th>Possible Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Design Section</td>
<td>Any defined concrete section</td>
<td>Analysis section</td>
<td>The design section for the selected frame objects.</td>
</tr>
<tr>
<td>Framing Type</td>
<td>High Ductile, Normal Ductile, Ordinary NonSway</td>
<td>High Ductile</td>
<td>The Framing Type is used for ductility considerations in the design.</td>
</tr>
<tr>
<td>Live Load Reduction Factor</td>
<td>$\geq 0$</td>
<td>Calculated</td>
<td>The reduced live load factor. A reducible live load is multiplied by this factor to obtain the reduced live load for the frame</td>
</tr>
</tbody>
</table>

Appendix D
Concrete Frame Overwrites
<table>
<thead>
<tr>
<th>Item</th>
<th>Possible Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unbraced Length Ratio (Major)</td>
<td>≥ 0</td>
<td>Calculated</td>
<td>Unbraced length factor for buckling about the frame object major axis. This item is specified as a fraction of the frame object length. Multiplying this factor times the frame object length gives the unbraced length for the object. Specifying 0 means the value is program determined.</td>
</tr>
<tr>
<td>Unbraced Length Ratio (Minor)</td>
<td>≥ 0</td>
<td>Calculated</td>
<td>Unbraced length factor for buckling about the frame object minor axis. Multiplying this factor times the frame object length gives the unbraced length for the object. Specifying 0 means the value is program determined. This factor is also used in determining the length for lateral-torsional buckling.</td>
</tr>
<tr>
<td>Effective Length Factor (k Major)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Effective length factor for buckling about the frame object major axis. This item is specified as a fraction of the frame object length.</td>
</tr>
<tr>
<td>Effective Length Factor (k Minor)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Effective length factor for buckling about the frame object major axis. This item is specified as a fraction of the frame object length.</td>
</tr>
<tr>
<td>NonSway Moment Factor (Bns major)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Nonsway moment magnification about the frame object major axis.</td>
</tr>
<tr>
<td>NonSway Moment Factor (Bns minor)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Nonsway moment magnification about the frame object minor axis.</td>
</tr>
<tr>
<td>Sway Moment Factor (Bs major)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Sway moment magnification about the frame object major axis.</td>
</tr>
<tr>
<td>Sway Moment Factor (Bs minor)</td>
<td>&gt; 0</td>
<td>Calculated</td>
<td>Sway moment magnification about the frame object minor axis.</td>
</tr>
</tbody>
</table>
Appendix E
Error Messages and Warnings

Table E-1 provides a complete list of Concrete Errors messages and Warnings.

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Beam concrete compression failure</td>
</tr>
<tr>
<td>2</td>
<td>Reinforcing required exceeds maximum allowed</td>
</tr>
<tr>
<td>3</td>
<td>Shear stress exceeds maximum allowed</td>
</tr>
<tr>
<td>4</td>
<td>Column design moments cannot be calculated</td>
</tr>
<tr>
<td>5</td>
<td>Column factored axial load exceeds Euler Force</td>
</tr>
<tr>
<td>6</td>
<td>Required column concrete area exceeds maximum</td>
</tr>
<tr>
<td>7</td>
<td>Flexural capacity could not be calculated for shear design</td>
</tr>
<tr>
<td>8</td>
<td>Concrete column supports non-concrete beam/column</td>
</tr>
<tr>
<td>9</td>
<td>$k \cdot L/r &gt; 115, \ zeta_2 &lt; 0, \ eta &lt; 1.0$ (GB50010 7.3.10)</td>
</tr>
<tr>
<td>Error Number</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>10</td>
<td>Column is overstressed for P-M-M</td>
</tr>
<tr>
<td>11</td>
<td>Axial compressive capacity for concrete exceeded (TBM 6.4.2)</td>
</tr>
<tr>
<td>12</td>
<td>Beam frames into column eccentrically (11.6.3)</td>
</tr>
<tr>
<td>13</td>
<td>Torsion exceeds maximum allowed</td>
</tr>
<tr>
<td>14</td>
<td>Reinforcing provided is below minimum required</td>
</tr>
<tr>
<td>15</td>
<td>Reinforcing provided exceeds maximum allowed</td>
</tr>
<tr>
<td>16</td>
<td>Tension reinforcing provided is below minimum required</td>
</tr>
<tr>
<td>17</td>
<td>$k \cdot \frac{L}{r} &gt; 30$ (GB 7.3.10)</td>
</tr>
<tr>
<td>21</td>
<td>The column is not ductile. Beam/column capacity ratio is not needed.</td>
</tr>
<tr>
<td>22</td>
<td>The load is not seismic. Beam/column capacity ratio is not needed.</td>
</tr>
<tr>
<td>23</td>
<td>There is no beam on top of column. Beam/column capacity ratio is not needed.</td>
</tr>
<tr>
<td>24</td>
<td>At least one beam on top of column is not of concrete. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>25</td>
<td>The column on top is not concrete. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>26</td>
<td>The station is not at the top of the column. Beam/column capacity ratio is not needed.</td>
</tr>
<tr>
<td>27</td>
<td>The column is not ductile. Joint shear ratio is not needed.</td>
</tr>
<tr>
<td>28</td>
<td>The load is not seismic. Joint shear ratio is not needed.</td>
</tr>
</tbody>
</table>
### Error Messages and Warnings

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>There is no beam on top of column. Joint shear ratio is not needed.</td>
</tr>
<tr>
<td>30</td>
<td>At least one beam on top of column is not concrete. Joint shear ratio is not calculated.</td>
</tr>
<tr>
<td>31</td>
<td>The column on top is not concrete. Joint shear ratio is not needed.</td>
</tr>
<tr>
<td>32</td>
<td>The station is not at the top of the column. Joint shear ratio is not needed.</td>
</tr>
<tr>
<td>33</td>
<td>Beam/column capacity ratio exceeds limit.</td>
</tr>
<tr>
<td>34</td>
<td>Joint shear ratio exceeds limit.</td>
</tr>
<tr>
<td>35</td>
<td>Capacity ratio exceeds limit.</td>
</tr>
<tr>
<td>36</td>
<td>All beams around the joint have not been designed. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>37</td>
<td>At least one beam around the joint has failed. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>38</td>
<td>The column above the joint has not been designed. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>39</td>
<td>The column above the joint has failed. Beam/column capacity ratio is not calculated.</td>
</tr>
<tr>
<td>40</td>
<td>All beams around the joint have not been designed. Joint shear ratio is not calculated.</td>
</tr>
<tr>
<td>41</td>
<td>At least one beam around the joint has failed. Joint shear ratio is not calculated.</td>
</tr>
<tr>
<td>42</td>
<td>The column above the joint has not been designed. Joint shear ratio is not calculated.</td>
</tr>
<tr>
<td>Error Number</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>43</td>
<td>The column above the joint has failed. Joint shear ratio is not calculated.</td>
</tr>
<tr>
<td>45</td>
<td>Shear stress due to shear force and torsion together exceeds maximum allowed.</td>
</tr>
</tbody>
</table>
References


Specification for Structures to be Built in Seismic Areas (EDP 2007), Official Gazette No. 26454 and 26511, Ministry of Public Works and Settlement, Government of Republic of Turkey.
